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This chapter provides an overview of new features and enhancements for Blackbaud Internet Solutions
4.0. For information about how to install or update to this version, see the Infinity Platform Installation
and Upgrade Guide.

Internet Explorer 11 Support
Blackbaud Internet Solutions now includes administrative and website browser support for Internet
Explorer 11 (IE11). For example, you can use IE11 to create a web page from Site explorer, Pages &
templates, and a website user can use it to access the page on your site.
To support the full-page functionality testing that is required for the new browser, Internet Explorer 8 is
no longer supported.
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Note: When you use non-supported browsers, you can still log in and use the program and website
pages, but some features may not render correctly.
For a full list of supported browsers, refer to the System Requirements.

Image Library
To help support profile image enhancements in this version and to provide better image search
functionality, the new Image owner field now appears on the Search tab in Image library. Use this field
to search for an image by the owner's first name or last name. The image owner is the person who
originally uploaded the image to your website. These images may have been uploaded by someone at
your organization for a web page or they may have been uploaded by a website user for a profile
page.
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Note: For more information about the profile image enhancements, see Profile Form on page 1.
Learn more about the Image library

Blackbaud Secure Payment API
Blackbaud Internet Solutions includes new API endpoints that allow custom parts to use Blackbaud’s
secure payment page. For example, a customization can pre-populate the Blackbaud secure payment
page with biographical information entered on the custom part to improve data entry speed for
donors. A customization can also store a donor’s credit card information.

Note: The Blackbaud secure payment offers additional flexibility, but comes with additional
complexity. If you host your own website, we strongly recommend only developers knowledgeable
in all areas of customizations design this page. This includes using endpoints, objects, and the API, as
well as writing HTML and JavaScript code. Users without this expertise should not design this page.
For information about the API, see the Developer Guide. If Blackbaud hosts your website,
customizations can only be completed by Blackbaud or one of our designated partners. For more
information, please contact your Blackbaud Account Executive.
The following end points are now available.

l AmountAsCurrency
l ApplicationIdentifier
l ApplicationPreferredName
l Note
l Source As TransactionSource
l Transaction
l VerificationMethod As VerificationMethod

In Blackbaud Internet Solutions 3.0 service pack 5, the following endpoints were added to support
this functionality.

l BBNCExtensions.Parts.CustomPartBBSPEditorBase
l BBNCExtensions.Parts.CustomPartBBSPDisplayBase
l BBNCExtensions.API.NetCommunity.Utility.SecurePayments

o StoreCardInfo
o CardNotPresent
o TransactionResponse
o Redirect

Parts
The following Parts enhancements are available.
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Language Tab Changes
Updates to the Language tab include a new default message for incorrect reCAPTCHA entries on forms
and an option to change the default value that appears in drop down fields.

Note: For information about updates to the Language tab for the Donation Form and Payment 2.0
parts, refer to Donation Form on page 1 and Payment 2.0 on page 1.

reCAPTCHA Failed Message
The default message that appears when website users enter incorrect values for reCAPTCHA images on
forms is changed. Previously, the message instructed users to enter "the words" shown in the
reCAPTCHA image. Now, the message instructs them to enter "the characters" since the images
typically include both text and numerical values.

To change the new default message, navigate to the Language tab on the parts that include
reCAPTCHA and update the text in the reCAPTCHA failed message row.
This table lists the Language tab category for each part that includes the row.

Part Category
Donation Form Validation Messages

eCards reCAPTCHA

Payment Validation Messages

Payment 2.0 Validation Messages

User Login reCAPTCHA

Default Value for Drop Down Fields
A new Default value for drop down fields option is available on the Language tab so you can specify
the text that appears when no value is selected for a field. Previously, <Please Select> always appeared
as the default value, regardless of a page's language setting.
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This table lists the category where the option appears for each part.

Part Category
Donation Form Donation Information

Event Registration Form Registration

User Login Registration Form

Directory
Show Me: Review the walkthrough to learn more
When website users open profile pages from Directory part search results, a new Back to search
results link appears at the top. Users click the link to return to the directory and view their search
criteria and results.
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This website usability enhancement eliminates the need for users to click menu links or the browser
back button to return to the directory page. It also saves users time from entering search criteria again.

Note: This link does not appear for Chapter Manager part directories.

eCards
A new Require eCard recipient's name field appears on the eCards part to prevent blank values in
merge fields that you add to eCard messages. When you select this option, the program requires
website users to enter a value for First name.

Transaction Manager
When you design a Transaction Manager part, the Select the tabs to display section now appears so
you can select whether to display only the History or Active tabs on your website.

To display both tabs on your site, you can select Both tabs. When you do this, a field appears on the
right for you to select the tab to display when users first access the part on a page.
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Tip: When you upgrade to this version, both tabs continue to appear on your site and the Active tab
still displays first.
In addition, the Language tab text you enter in the "Transaction Manager - Help Text" category to
clarify each tab's purpose to users now appears at the top of the tab.

These improvements were made to provide additional flexibility with the part based on your
organization's needs and preferences. For example, if you did not want the Active tab to appear in the
past, you can now remove it. If you want both tabs to appear, but prefer the History tab appears first,
you can now select to do this.
Learn more about the Transaction Manager
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Email Templates
Show Me: Review the walkthrough to learn more
To improve email marketing for mobile users, six new mobile friendly email templates are available
for you to copy and use as new templates. These templates are more narrow in width and include
larger fonts for improved usability on mobile devices. They also render more consistently across
mobile devices, browsers, and desktop and web-based email programs. You can easily identify these
in the email templates grid by viewing templates with “Placeholder” in the Description column.

To copy a mobile friendly template, select the one you need. In the Action column, click Click here to
copy this email template. After you copy it, update all placeholder text with your unique content in
the new email template. For example, you can replace the merge field placeholder text with merge
fields in the HTML editor. You can also replace the sample logo banner with your organization's logo
banner.
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Below is a list of the six mobile friendly email templates. To secure the content in the templates, you
cannot edit or delete them.

l Campaign Email #1 – Kickoff
l Campaign Email #2 – Follow-up
l Campaign Email #3 – Last Chance
l eNewsletter Template
l Holiday Greetings Template
l One Column Template

Tip: One copy of each mobile friendly email template exists in the program. When you host multiple
websites, you access them in each site's Templates area.
Learn more about the email templates

Administration
The following Administration enhancements are available.

User Image Options Setting
To help support the profile image enhancements and so you can improve how you organize images, a
new Default profile image folder field now appears in site settings for images. In this field, select the
default folder profile images upload to in Image library.

Note: For more information about the profile image enhancements, see Profile Form on page 1.

When you select Require approval for all images uploaded by users, you must approve each profile
image in the Image library before it appears on your website. Until you do this, it only appears for the
user who uploads it.
Learn more about image settings
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Custom Error Page
Show Me: Review the walkthrough to learn more
In Sites & settings, a new Error page field is available under Pages on the Settings tab for default,
parent, and child sites. In the field, you select a web page from Pages & templates to appear if errors
occur.

This allows you to create a custom message and include information to help identify the causes of
errors.
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Note: If you do not select an error page, system messages from Internet Information Service (IIS)
appear when errors occur.
To provide detailed information in the message, use the new error merge fields in a Formatted Text
and Images part. The merge fields insert responses from the website server if pages do not load
properly. The error merge fields include:

l Error code — The numeric portion of a standard response code, such as 404 or 406.
l Error description — The reason for a standard response code, such as not found or not

acceptable.
l Error log ID — The database number that corresponds to the server error.

Note: Error log IDs help Blackbaud Support track the reasons for errors on your website.
Learn more about the custom error setting

Favicon Images
Show Me: Review the walkthrough to learn more
You can now add branding to your web address so users can quickly associate it with your
organization. Use the new Favicon image field in general site settings to select a small icon to
represent your website. The image appears in browser address bars and locations where users save
your website URL, such as browser favorite lists.
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To add a custom favicon to your site, click Browse beside the Favicon image field and select an .ico
image file. We recommend you upload a 16x16 or 32X32 pixel image for maximum display quality in
modern browsers on desktop and mobile platforms. If you select an image with a different file type or
size, or if the file does not convert correctly to .ico, the file may not render correctly in all browsers.

Note: The image file size must be 50KB or less.

Previously, websites rendered favicons in browser address bars only when an .ico file was sized and
saved in Image library.

Tip: If Blackbaud hosts your website, we recommend you add a favicon image to prevent issues when
there are environment changes.

Forms
The following Forms enhancement is available. For more information, see the Forms Guide.

Communication Preferences Form: Active EmailAddresses
When you include the General Correspondence element on a Communication Preferences form, only
active email addresses now appear. Previously, the element included inactive email addresses but not
inactive mailing addresses. This change creates consistency between the email and mailing address
behavior.

21 CHAPTER 1



Tip: To ensure correct email addresses appear on forms, we recommend you properly maintain
historical dates on email addresses.

Profile Update Form
Show Me: Watch a video about the new profile image enhancements and review the walkthrough to
learn more.
To simplify profile image management for your organization and improve the website user experience
for profile images, the Profile Update Form now includes a Profile image element. When you include
this in the design area, you provide the ability for website users to easily add, edit, or remove profile
images.

Note: When you implement this new profile image feature, the program automatically uses the most
recent profile image for a user as the current profile image.

When a profile image displays on a profile web page, a square thumbnail of the user's image appears.
The user can change or remove the image by clicking the links below it.
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Note: When a website user has an existing profile image and uploads a new one on the profile page,
the new profile image overwrites the previous image. This occurs on your website and in Image
library.
To select the portion of it that appears as the profile, the user clicks the thumbnail image. On the
screen that appears, the user drags the box to highlight the portion of the image to display and a
thumbnail example appears on the right.
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Before a user uploads a profile image, a default silhouette image appears as the profile. A link to add
an image appears below the silhouette.
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Tip: To help support the profile image enhancements and improve how you organiz and search for
profile images, there are additional new features in Image library and Administration. For more
information, seeImage Library on page 9 andUser Image Options Setting on page 18.

User Photos Form
Previously, profile images saved as a profile image type when they were uploaded on the User Photos
Form part. With this release and the profile image enhancements on the Profile Update Form, images
uploaded on the User Photos Form save as a personal type. You can design these images to display on
the web page with the profile image from the Profile Update Form.

Warning: After you implement the new profile image on the Profile Update Form, we recommend
you remove any User Photos Form parts that display profile images. If you do not remove them from
your website, you risk inadvertently overwriting profile images. The most recent image uploaded by
users remains as the current profile image automatically when you use the new profile image.
Therefore, you can remove these User Photos Form parts from your site.
When an image's tag is the same as the tag selected on the User Photos Form part, the image displays
on the page regardless if the image type is personal or profile. Previously, only profile image types
displayed. To view personal and profile image types in your database, in Image library, select the type
to view in the Type of image field on the Search tab. You can view the tags for an image on its
properties.
Learn more about the User Photos Form
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Profile Display
As a part of the profile image management enhancements, the Profile Display part now includes a
Profile image merge field in the HTML editor and height and width fields for you to configure
maximum profile image sizes.
In the Max height/width for full-size image field, you enter the maximum display height and width
for full-size profile images that display when users click thumbnails on the web page. In the Max
height/width for thumbnails field, you enter the maximum height and width for profile image
thumbnails on the web page.

The HTML editor includes the Profile image merge field on the Individual tab. To display the image a
user uploads on the Profile Update Form, include this merge field in the design box.
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When you do this, the image appears on the read-only profile display web page for other website
users to view. The square cropped image that a user selects on the Profile Update Form displays as the
profile image thumbnail. When website users click the thumbnail, the full-size image displays.
Learn more about Profile Display
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These features were introduced in Service Packs after the original Blackbaud Internet Solutions 4.0
release.

Service Pack 1
Part RemovalSafeguard
To prevent you from inadvertently removing active content from your website, you can no longer
delete parts when they are associated with web pages. When you attempt to delete a part that is
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associated with a single site, or shared across multiple sites, a message appears to inform you that you
cannot remove it because it exists on a page.

To identify the pages where the part appears, select the part's Usage tab.
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Security Update
As part of our normal product improvement processes, we review our security measures, protocols,
and infrastructure on an ongoing basis. Blackbaud Internet Solutions was automatically updated in this
release to include security improvements which address vulnerabilities that could potentially
compromise the integrity of our product. Please refer to this list to determine whether your
organization needs to take any action.

l If your organization uses a customization to provide website registration or login functionality,
the customization may not work correctly if it directly accesses the ClientsUsers table in the
database. Instead, we recommend customizations use the methods contained in the
Blackbaud.Web.Content.Core assembly and User class. If your organization uses standard
Blackbaud Internet Solutions functionality for user login and password reset or if your
customization calls passwords via the Blackbaud.Web.Content.Core assembly and User class, no
action is required on your part.

l If your organization uses an iFrame from a third party website to direct users to Blackbaud
Internet Solutions Donation, Event Registration, Membership, Sponsorship Form, or Sponsorship
Search parts, you need to update the website to direct users to a form on a Blackbaud Internet
Solutions page. We recommend you design the page to include the same look and feel as your
third party site so that users seamlessly transition to the Blackbaud Internet Solutions page.

Note: Blackbaud historically has not recommended the use of iFrames due to security issues.
For more information, read the Knowledgebase article here.

Password Reset Page Link
To improve password reset security in email messages from Blackbaud Internet Solutions, you now
select a user login password reset page from the Create link to a special page option on the HTML
Editor when you design the email message.
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Tip: The ability to create a special page to link to your user login page (that you define for Page
settings in Sites & settings) previously existed. With this feature, any page that contains a User Login
part now appears from the drop down and you want to select the user login page that navigates users
to your forgotten password page.
This new link remains active in an email for the user to take action to reset the password any time.
When an email recipient clicks the link, a secure page appears with a Forgotten Password field for the
user to enter their email address.
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After the email address is submitted, another email sends to the user. That email contains another link
that returns the user to the password reset page on your website.

Previously, the Password merge field was available in email messages that use a Registered Users data
source. With this update, this merge field no longer includes the password in an email. When a
recipient receives the message, the placeholder for the field is blank. As a result, make sure you
remove the Password field and create user login password reset page links in email messages to
guide your users to reset their password.

SocialMedia Login Welcome Email
Now when Blackbaud Internet Solutions website users register for the site with social media login
credentials, the program sends them a confirmation email to welcome them to the site. Previously, the
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program did not send these users an email. The program uses the same welcome email template you
configure for other website registrants, but it merges "<social media username> via <social media
account>" in the Username field.

Service Pack 2
Security Update
As part of our normal product improvement processes, we review our security measures, protocols,
and infrastructure on an ongoing basis. Blackbaud Internet Solutions was automatically updated in this
release to include security improvements which address vulnerabilities that could potentially
compromise the integrity of our product.

Help Text in EmailMessages
New help text is available for the Send after date field in Messages to explain that after you click Send
final, the website does not process the email until the date and time you enter in the field. It also
explains that if you delete the email before that date, the program does not process it and does not
send it to recipients.

Pages & Templates Enhancements
The following Pages & templates enhancement is available.

Search Filters
To help you quickly find the pages you need, new search filters are available. From the Search tab, you
can use the new My content or Filter by template options to narrow the results to pages you created
or that use a specific template.
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Also, when you search for parts to insert on pages, the My content filter is available so you can limit
the list to the parts you created.

Additional Copy Part Option
You can now copy parts from the Page content tab when you highlight a page in the list of pages. This
change reduces the number of clicks required to copy parts when you navigate to them from the list
of pages. Previously, you had to edit the pages to copy them or copy them from Parts.

New Sort Options
You can now use Page name or the new Last modified column to sort the list of pages. These changes
help you to quickly find the pages you need.

Note: When you sort the list, the pages appear in ascending order. Pages that begin with the letter A,
or include the oldest changes, appear at the top of the list.

Parts Search Filter
To help you quickly find the parts you need, a new search filter is available. From the Search tab, you
can use the new My content option to narrow the results to parts that you created.
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Profile Update Form
When you design the Profile Update Form for your Blackbaud Internet Solutions website, the Email
addresses element under Contact information has changed. To improve email address privacy for
website users, the new Make my primary email address private checkbox appears in the design area
when you add the element to a form.

To display the checkbox on your web page so users can select whether to mark the primary email
address as private, select "Yes" in the Privacy enabled row on the Properties pane. In the Privacy
caption row, you can enter custom text for the checkbox to display on the page.

Note: When users select the new Make my primary email address private checkbox on your web
page, it also designates their primary email address as private for the Directory and Profile Display
parts on a web page.

reCAPTCHA InstructionalText
The default field label that appears for the image prompt on payment and new user registration forms
that include reCAPTCHA images is changed. Previously, the label instructed users to "type the two
words" shown in the reCAPTCHA image. Now, the text instructs them to "enter the text" since the
images typically include characters that do not form words.
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To change the new default message, navigate to the Language tab on the parts that include
reCAPTCHA. Next, select the reCAPTCHA category and update the text in the Image prompt row.
The row is available for these parts:

l Donation Form
l Payment
l Payment 2.0
l User Login

Site Administrators Filter for Users
Now when you use filters in Users, you can identify the people who are site administrators. Previously,
you could only filter by the roles you added to your website. This change helps you quickly identify
people with administrative access when you need to change rights, such as when a person is no longer
employed by your organization.
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Service Pack 3
Block Sending EmailMessages and Scheduled Email
Your System Administrator can now use the BlockAllEmails and BlockScheduledEmails settings to
prevent inadvertently sending email messages and scheduled email from a test environment. To do
this, you must add <add key="BlockAllEmails" value="True" /> and <add key="BlockScheduledEmails"
value="True" /> to the appSetting node in both web.config files for Blackbaud Internet Solutions and
Blackbaud CRM. By default these settings do not appear in the file, and the default behavior is False.

Tip: The BlockScheduledEmails setting only blocks emails sent from the Email, Scheduled emails
functional area. It does not block scheduled emails set to send when you use the Send after date
field in Messages or Marketing Efforts.
If Blackbaud Hosts your website and you want to request an update to your web.config file, contact
Customer Support from Blackbaud's website.

Note: With this change, the ProcessCMSEmail.BusinessProcess.vb file has been updated for the
Process CMS Email Business Process in Blackbaud CRM.

Service Pack 4
BBIS Event Registration Transaction Batch: Donor Option
When a website user submits an event registration on your Blackbaud Internet Solutions website and
you process it in the BBIS Event Registration Transaction Batch in Blackbaud CRM, you can now select
"Donor" in the Registrant column on the Guests tab when you view transaction details. Select this
option when the donor submits their information as a guest instead of the primary registrant

39 CHAPTER 2

https://www.blackbaud.com/support/support.aspx


You can also change the registrant from Donor to Linked constituent, New constituent, or Unknown
guest.

Tip: Previously, you could select “Donor” in the ClickOnce version of Blackbaud CRM.

Middle Name Field
The Donation Form, Payment, and Payment 2.0 parts now include the Middle name field under
Additional fields.

Note: This change satisfies the Canadian Revenue Agency's requirements for donation receipts.
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Service Pack 5
Delete EmailMessages and Newsletter Issues Permanently
Note: With the 4.0 Service Pack 8 release, a new Automatically delete email older than option
appears on this setting for you to delete messages and newsletters based on whether the email is
beyond a certain number of days, months, or years. For more information about this feature, refer to
Delete Email Messages and Newsletter Issues Permanently Update on page 47.
To improve performance and delete email messages and newsletter issues in bulk, you can now run a
process to permanently delete these from your database. In Email, when you delete an email message
or newsletter issue, it only soft deletes. When you soft delete email, it removes from the user interface,
but the data remains in the database. To delete this email permanently from the database, schedule
the new Delete email permanently organization setting in Administration.
To schedule the frequency and other options for the process, navigate to the setting under Schedules.

Under Frequency, you schedule a day and time frequency to run the process to permanently delete
email messages and newsletter issues in the Every [ ] day(s) at [ ]:[ ][ ] fields.

Tip: To prevent the program from running this process, select Never. By default, this is selected
when you upgrade to this version.
Under Options, you enter the number of minutes to allow the process to run and you also enter the
number of days to retain soft deleted email messages and newsletter issues in your database so that
the remainder of your soft deleted email deletes permanently during the process.

Important Tips
l To prevent the possibility of anyone scheduling the Delete email permanently setting, your

System Administrator can use the ShowEmailDelete web.config setting to remove it from the
Schedules tab. By default, the setting is <add key="ShowEmailDelete" value="True"/>. To
remove it from the tab, enter False.

l To run the process as efficiently as possible, we recommend you schedule it to run after hours
when users are less likely to access Blackbaud Internet Solutions and Blackbaud CRM.
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Note: If you schedule this process and the Email jobs process to run at the same time, please
be aware your email job process may experience a delay.

l Depending on the volume of email you need to permanently delete, the process can exceed the
amount of time you enter in this field. When this occurs, the process pauses and starts again
according to the interval you scheduled in the Every [ ] day(s) at [ ]:[ ][ ] fields.
For example, you need to run this process for the first time. Due to the high volume of email to
initially delete, you can schedule it to run every night (1 day) at 1 AM for 300 minutes (5 hours).
The process runs longer than 300 minutes so it pauses until the next night at 1 AM. At that time,
it starts again for the next 300 minutes.

l To determine the email that remains soft deleted and the email that deletes permanently, the
program compares the sent date of the email to the number you enter in the Delete email that
is older than [ ] day(s) field. It is important to consider this as you determine the number of
days to enter in this field.
For example, today's date is March 15 and you enter "90" in this field. Email that was sent on
January 15 remains soft deleted in your database. However, email that was sent on November 15
deletes permanently.

Email Updates in Blackbaud CRM
To learn more about changes in Blackbaud CRM after you permanently delete email messages and
newsletter issues, review this section.

l Constituent Record - Before you permanently delete email using this process, email messages
and newsletter issues on a constituent record in Blackbaud CRM appear with a link beside the
Subject field. You can click this link to open the message in Blackbaud Internet Solutions. After
you run this process, the link disables beside the Subject field because you can no longer open
it in Blackbaud Internet Solutions. Also, if a recipient opens an email after it has been deleted
permanently, submits a donation from one, or clicks links in it, the Opened, Donated, and Links
clicked fields do not update to reflect this information. The data that appeared in these fields
when it was deleted from your database remains in place. For historical purposes, the other data,
such as Email name and Date sent, also remain on the constituent record.
In Blackbaud CRM, email message and newsletter issue information displays on the
Communications second-tier tab on the Communications tab.

l Appeal Record - Blackbaud Internet Solutions email for an appeal appears in the Blackbaud
Internet Solutions emails grid on the Mailings tab of an appeal record in Blackbaud CRM. After
you run this process, the calculations for an email, such as response rate and the number of click
throughs, no longer updates. However, the data at the time the email is permanently deleted
remains in the grid.

l CMS Delete Email Business Process - From Administration, Business processes in Blackbaud CRM,
you can open the CMS Delete Email Business Process to view details about each instance of this
process. To do this, on the Business Processes page, select the History tab. In the Process type
field, select CMS Delete Email Business Process and click Apply. The processes appear in the grid
below for you to view details such as the status of the process and the date and time the process
ended.
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For more information about records and processes in Blackbaud CRM, refer to the Blackbaud
CRM help file.

Advanced Donation Form - Pledge Installments API
When you use the Advanced Donation Form to create a custom donation web page, Blackbaud
Internet Solutions now includes API end points for pledge installments. Pledge installments are the
payments a donor makes for a pledge according to a defined time schedule. These end points allow
you to capture pledge and installment information, and they also allow you to tokenize a credit card
for future pledge installment payments.

Note: The pledge installments API offers additional flexibility, but comes with additional complexity.
If you host your own website, we strongly recommend only developers knowledgeable in all areas of
customizations design this feature. This includes using endpoints, objects, and the API, as well as
writing HTML and JavaScript code. Users without this expertise should not design this page. For
information about the API, refer to the Developer Guide. If Blackbaud hosts your website,
customizations can only be completed by Blackbaud or one of our designated partners. For more
information, please contact your Blackbaud Account Executive.
The following end points are now available.

l payment.Gift.PledgeInstallment.NumberOfInstallments (integer)
l payment.Gift.PledgeInstallment.InstallAmount (number)

Recurrence for these new end points uses these existing end points.
l payment.Gift.Recurrence.Frequency
l payment.Gift.Recurrence. DayOfMonth
l payment.Gift.Recurrence. Month
l payment.Gift.Recurrence. StartDate

Also, two new javascript functions are now available.
l getRecurringGiftInstallmentAmount(totalGiftAmount, numberOfInstallments)

This calculates the price of each installment for a recurring gift based on the number of
installments the website user wants make.

l getRecurringGiftLastPaymentDate(numberOfInstallments, frequencyCode, installmentStartDate,
installmentMonth, installmentDayOfMonth)
This calculates the end date of a recurring installment based on the number of installments the
website user wants make.
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Service Pack 6

Blackbaud Secure Payment Page Upgrade
To provide an optimal check out experience for website users on multiple devices, you can now
upgrade your static Blackbaud secure payment web pages to responsive web pages that use HTML5 or
CSS3. You can select to upgrade each secure payment page individually, or you can upgrade all pages,
across all of your websites, at the same time.

Note: The Blackbaud secure payment page processes credit cards only; it does not process direct
debits. This functionality has not changed between the static and responsive web page upgrade.
After you upgrade Blackbaud secure payment pages from static to responsive, you cannot use static
pages again.
Upgrade an Individual Secure Payment Page
In Pages & templates, the new Blackbaud secure payment preview tab appears from page properties
when the page contains a part that integrates with the Blackbaud secure payment page. For example, if
the page contains a Payment 2.0 part that uses the Blackbaud secure payment page, the tab appears.

The template examples that display on the tab are previews of the secure payment page's appearance
with your organization's content. Template 1.0 displays a preview of the existing static page. Template
2.0 displays a preview of the responsive page after you upgrade.

Tip: Use the horizontal bar to scroll and mimic page responsiveness for Template 2.0. To toggle the
template examples between the desktop and mobile style sheet associated with the page, select the
browser option in the Preview with field.
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To upgrade the Blackbaud secure payment page to a responsive page, select Use responsive web
page for Blackbaud secure payments. When you save the page, it upgrades immediately. Also, any
recent changes to your style sheets, layouts, templates, and page also push to the Blackbaud server to
update the page.

Upgrade All Secure Payment Pages, Across All Websites
In Administration, Sites & settings, the new Update all Blackbaud secure payment pages to a
responsive web page checkbox appears under the Secure payment template update setting.

When you select this and click Update templates, the process begins to upgrade all static secure
payment pages to responsive pages. Also, any recent changes to style sheets, layouts, templates, and
pages push to the Blackbaud server to update all secure payment pages.

Organization Setting: Non-Production Environment Checkbox
From Administration, Sites & settings, you can now select This is a non-production environment when
you want to test or disable specific functionality in an environment that is not available to website
users and email recipients. When this checkbox is clear, your environment is live and set to Production.
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Tip: When you upgrade to this version, the checkbox is not selected and your website remains in
your Production environment. If you do select the checkbox, the setting applies to each website you
host, whether it is one site or multiple sites.
Currently, there are two features you can alternate between Production and Non-production
environments. The following table lists the feature and what you can do in each environment.

Feature Non-production Production
Secure payment
template update
organization
setting

When you update Blackbaud secure
payment pages from static to responsive
pages, a copy of each page template is
created for you to view and test in the Non-
production environment. This avoids
interruption on your live, Production site.

When you update Blackbaud secure
payment pages from static to responsive
pages in Production, the pages are live on all
of your live websites.

Email jobs
organization
setting

Disable email jobs sent from the Email,
Scheduled emails functional area.

Tip: The Non-production environment does
not prevent an email job from sending to
recipients when you use the Send after date
field in Messages or Marketing Efforts.

Blackbaud Internet Solutions sends
messages for email jobs from the Email,
Scheduled emails to recipients as expected.

Service Pack 7
There are no new features in Service Pack 7.
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Service Pack 8
Email Settings
You can now easily indicate whether to send multiple or single copies of emails when two or more
constituent records include the same email address. This setting eliminates the need for you to
remove duplicates before you send emails.
To send one email to multiple constituents with the same email address, clear the new Send a unique
email to each constituent who shares the same email address option in Sites & settings. You
typically select this when you want constituents, such as spouses, who share email addresses to each
receive a copy of messages.

Note: This checkbox is selected by default. You do not need to clear it if you want the program to
continue to send emails to each constituent.
This setting applies to constituents in an email list with a data source of Constituent or Imported.
When you clear the checkbox, merge fields populate with information for the constituent whose
record has been in the database the longest. When you select the checkbox to send a unique email to
each constituent, merge fields populate with each constituent's specific information.

Delete Email Messages and Newsletter Issues
Permanently Update
As a follow up to the new Delete email permanently organization setting in Administration (released
in version 4.0 Service Pack 5), you can now select to delete messages and newsletter issues based on
whether the email is beyond a certain number of days, months, or years. This enhancement
automatically deletes email from the Email area of Blackbaud Internet Solutions and the back end of
the database.

Tip: For more information about the original implementation of this setting, refer to Delete Email
Messages and Newsletter Issues Permanently on page 41.
To delete email permanently based on age, schedule the new Automatically delete email older than
option.
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To delete email older than a certain age, select the second option. In the field beside it, enter the
number of days, months, or years to delete email, and then select an option in the drop down. For
example, to delete email older than two years, enter "2" in the field and select Years.

When you use this setting, the program calculates the age based on the email sent date. The process
then deletes the applicable email from Email before deleting it from the back end of the database. If
you leave the default as Never, the program only removes email from the back end of the database.

Note: To prevent the program from processing the Delete email permanently setting, it is
important to remember that you select Never under Business process frequency. This is part of the
original feature that released with Service Pack 5. Also, as a result of this new Automatically delete
email older than feature, the Delete email that is older than [ ] day(s) field has been removed from
this setting.
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Service Pack 9
User Login: Constituent Attributes
The User Login part now includes the ability to change the order of the constituent attributes
appearance on the form and modify their labels. Under Attributes, click and drag the dotted button
on the far left to move an attribute in the updated grid. To change the label text, enter it in the
Caption field.
These updates provide flexibility so you can specify how the attributes should appear on the form,
such as if you want them in the same order as they are arranged in Blackbaud CRM.

Email Address Type Field
To enable you to specify which email address to use for messages you send to constituents, a new
Email address type field is now available when you create templates from Email, Templates or
messages from Email, Messages. When a constituent does not have the email address type you select
in the field, the message is sent to their primary email address. For more information, see Design and
send an email message.
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Sending a Final Email
To increase email efficiency, we have enhanced the send final email process to help make sure the
correct group of recipients receive your intended email. Now, when you click Send final on an email
message, a new Send Status tab appears for you to view the target lists, the number of recipients in
each list, and when the lists were last refreshed.

Note: This new feature only applies to email sent from Messages.
To make sure the latest recipients are in the queries that the lists use, click Refresh Lists.

Note: You are not required to refresh the lists before sending the message. When you click Yes to
send the final message, lists that use dynamic queries automatically refresh. This does not apply to
lists that use static queries.
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A message appears for your review before clicking Start Refresh to begin the process.

Tip: It is important to read this message. It informs you that you can do other tasks in the program
while the refresh processes, but you cannot send the final email. It also states the refresh may take an
extended period of time depending on the size and complexity of your lists.
After the refresh completes, click Yes to actually send the final email to recipients.
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When you do this, one more refresh occurs automatically for lists that use dynamic queries. This may
cause the recipient numbers on the Sent Status tab to differ from the final sent numbers that appear in
email reports. If your lists use static queries, this does not apply. For more information about email
statuses, refer to the Email Guide.

Note: When you enter a date in the Send after date field, the email does not send until the date and
time you specify in that field.

Title Settings
In organization settings, the new Titles section allows you to filter the titles that appear in the drop
down list for Title fields on web pages. Previously, all the titles from Blackbaud CRM appeared in the
list. Use this feature to remove titles that are not frequently selected by website users, such as General
and Chief.

When you upgrade to this version and view the new setting, all active titles from Blackbaud CRM
appear with each checkbox selected. To make a title unavailable for your site, clear its checkbox and
click Save on the General tab.
Titles you do not select are only available on your website when users are logged in and their profiles
include existing titles that do not appear in the drop down list. In those instances, the program adds
the titles to their form drop down lists.

Note: If your website includes custom JavaScript to restrict Title field drop downs, we recommend
you test these fields on your site after you install this version. It is possible you no longer need this
customization.

SERVICE PACK NEW FEATURES 52



Integration Services Setting: Number of Records to Update
When you view the Blackbaud CRM integration service setting on the Schedules tab in
Administration, it now displays the number of records to update in Blackbaud CRM. This is an
informative way for you to monitor the amount of data the setting needs to process, which helps you
avoid integration delays from Blackbaud Internet Solutions to Blackbaud CRM.

When you select the hyperlink for the number of records to update, a screen appears that lists each
record type to update. The number of records to update for each type also appears, along with the
type's last integration date.

To view the latest data currently waiting for process from Blackbaud Internet Solutions to Blackbaud
CRM, select the Refresh icon. When the refresh completes, the date and time update to reflect when
you last refreshed the number.
Under Frequency, you also now specify the number of records to send to Blackbaud CRM during each
schedule in the updated interval and daily options.

Tip: This feature allows you to configure the number of records to update, which was previously not
user-configurable.
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Email Security Enhancement
Due to updated security enhancements, there is now more stringent security to enforce strong email
passwords.
Strong passwords must meet the following criteria:

l Are case-sensitive
l Must be a minimum of 8 of characters long
l Cannot contain any part of your full name
l Cannot contain any part of your account name
l Cannot be one of your last 24 used passwords
l Must contain a combination of uppercase letters, lowercase letters and numbers:

l Uppercase letters (A - Z)
l Lowercase letters (a - z)
l Numbers (0 - 9)

l May contain one of the following special characters: ! $ . # %
After updating to Service Pack 9, you may be required to change your password before you can send
email. To determine whether you need to change your password, go to CRM > Administration >
Configuration > Email Services and confirm if you can successfully connect. If you receive an error,
contact Support to help you update your password.

Service Pack 10
EmailPerformance Statistics Enhancements
To modernize email and improve statistical information to current industry standards, performance
statistics for email messages have been enhanced. To centralize the data, you now view most statistics
for an email message in one grid instead of clicking multiple tabs and sub-tabs. After you send a
message, its row on the Messages page updates to display the grid. The percentages and counts that
display update automatically each time you access the grid so you always view the latest statistics.

Note: The email performance statistic enhancements are only available in Email > Messages, not in
Email > Campaigns or Email > Newsletters.
From Email, Messages, select a message and click Click here to view report ( ) in the Action column.
The performance statistics grid displays below the message row.
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The top row of the grid displays the email activity percentages for Open rate, Click rate, and
Transaction rate, as well as the Average gift amount raised as a result of the message. You can hover
over each statistic title to view a description of how the value was calculated.
The bottom row of the grid lists email activity in total amounts for Recipients, Opens, Clicks, and
Transactions. You can click each amount to view a list of email addresses associated with the statistic.
The Total raised amount is also shown.
Next to the statistics grid, additional information displays.

Here you can view the distribution lists used for the message, the number of messages that were not
sent or that resulted in bounces and opt-outs, and the email job status. When you click the Not Sent,
Bounces and Opt-outs values, you can view more information about these statistics, such as the
associated email addresses.
Click Additional Information to display more details about URL performance, total number of views
and unique viewers, total number of transactions, and the message content and properties. You can
also export the email statistics to a *.csv file. Click Export, then select either Summary or Details.
The Email Status Log icon displays in the Action column and to the right of the statistics grid next to
Status. Depending on the status of the email job, the icon displays as one of the following:

- Completed

- In progress
- Failed

You can click the icon to display more information about the email status.
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Confirm EmailAddress Field
To improve email address accuracy, multiple parts now include the option to include a new Confirm
email address field. When you select to display it on a web page, website users must enter their email
address two times. Blackbaud Internet Solutions then compares the two email addresses to make sure
they match.

The following parts now include this field.
l Donation Form
l Event Registration Form
l Membership Form
l Sponsorship Form
l User Login Form
l Payment 2.0 Form

Security Update
As part of our normal product improvement processes, we review our security measures, protocols,
and infrastructure on an ongoing basis. Blackbaud Internet Solutions was automatically updated in this
release to include security improvements for credit card processing in compliance with Payment
Application Data Security Standard (PA-DSS). Please refer to this list to determine whether your
organization needs to take any action.
• Enhanced Password Protection: We now use industry-tested and accepted hashing algorithms to

encrypt and store user passwords. This provides stronger protection for user data as passwords are
no longer stored in the database. However, no changes are required by your organization if your
website uses standard password functionality in Blackbaud Internet Solutions.

Note: If your organization uses a customization to integrate your website with a third-party single
sign-on system, the customization may not work correctly. We recommend that you consult your
single sign-on system provider to determine how the PA-DSS 3.2 requirements may affect your
integration with Blackbaud Internet Solutions.

• Site-Wide Secure Pages: Previously, you could require encryption for all pages, secure content, or
administration pages in Sites & settings. Now, Blackbaud Internet Solutions requires encryption for
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all pages on your website to provide site-wide security and protect your users' connections to your
website. The URLs for all Blackbaud Internet Solutions web pages use “https" to securely render the
pages via Transport Layer Security (TLS) protocol. This provides three layers of protection:
encryption, data integrity, and authentication.

Note: If your web pages incorporate content from non-secure sites, the content may not display
or website users may receive a warning that the site has mixed content. This occurs because the
Blackbaud Internet Solutions page uses a secured HTTPS connection, but some of the content on
the page is referred by a non-secured HTTP URL. Non-secure content can be located in Formatted
Text or Unformatted Text parts, the page layout, or the site style sheet. To correct this issue,
identify affected parts and change the URL for the external content to a secured HTTPS
connection.

• Improved Security for Testconfig Page: Testconfig is a page on your Blackbaud Internet
Solutions website that reveals helpful information about your site's configuration, product versions,
server-to-server connectivity, and more. To improve its security, testconfig.aspx is now accessible
only from your local server.

JQuery Version Upgrade
With this release of Blackbaud Internet Solutions, we have upgraded the JQuery version from 1.7.2 to
1.12.3.

Support for InternationalState Fields
Blackbaud Internet Solutions now uses existing CRM address formats to determine whether to display
or hide the State field on all web pages that allow users to enter address information.
Previously when entering addresses for any nationality, the State field always displayed, except for the
UK, Australia, and New Zealand. Now, if a State value does not apply to the selected country, the State
field is hidden on the web pages. If the State value is in CRM international address formats for the
selected country, then the State field is visible on the web page and is required by Blackbaud Internet
Solutions.

Note: The State field still displays for the United States, United Kingdom, Australia, New Zealand and
Canada even if the State or State Abbreviation value is not included in the address format in CRM.
This enhancement was made to the following Blackbaud Internet Solutions parts:
• Donation Form
• User Login Form
• Payment 2.0 Form
• Event Registration Form
• Profile Update Form
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Upcoming Change for Email Forwarding
With Email Forwarding, website users could sign up and create a lifelong email address that is
forwarded to an email address that they select. This functionality was provided in Blackbaud Internet
Solutions via the Email Forwarding Form.
We have reviewed email forwarding needs and concluded that alumni and other users will be better
served by other email forwarding vendors that provide more advanced capabilities. For example,
solutions like Google's G-Suite (https://gsuite.google.com) offer full email hosting services for your
domain, including email forwarding.
In light of our research, we recommend that your organization transition from the program's built-in
email forwarding functionality to an alternate solution, such as that included with Google’s G-Suite, in
early 2017.
Blackbaud customer support representatives can assist you with retrieving the list of website users who
have currently signed up for email forwarding. You can then use this list to implement an alternate
solution of your choice.

Service Pack 11

Event Registration Form
This service pack includes a new Event Registration Form part with functionality improvements and
usability enhancements to both the Edit Part screen and the web pages that the part generates on your
website.
New functionality improvements for the part include increased support for appeal and campaign data
and integration with event preferences. Usability enhancements include better organization of the
part's design options to avoid scrolling, and help text improvements to clarify what appears on the
page. For website users, usability enhancements include a simplified registration process that has been
reduced to three steps and numerous quick links so users can autofill registrant data.

Show Me: Watch a video about the new Event Registration Form part.

Event Registration Form (Classic)
The original Event Registration Form part is now called Event Registration Form (Classic). It does not
upgrade to the new event part and remains available to use on your website with its original design.
There are a few features the Event Registration Form (Classic) includes that the new Event Registration
Form Edit part does not, such as Payment 2.0 part integration and the ability to link to another page
from the event. You may want to consider this when you create the new part.
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Event Registration Form: Website
When you include the new Event Registration Form part on a page in Site explorer, the registration
options appear on three separate pages on your website. Each page includes a status bar so website
users can view their progress as they complete the event registration process. Users can click the
button in the status bar to go to the previous or next page.

Note: The Step 3 Payment button appears when a user selects a paid event type on the Step 1
Selection page and then clicks Continue.
Step 1 Selection — The first page of the event registration process displays event details from
Blackbaud CRM such as the descriptions, start dates, and times for events. Website users select events
to attend and the number of registrants, and if you include a field for donations, they can also make
additional gifts. The summary of the user's selections displays at the bottom of the page and
dynamically updates as the user enters information.
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Step 2 Registration — On the second page, website users enter details for all registrants. To copy
contact information, users can select Use this address for all registrants and click Apply to all
registrants for certain fields. After users enter registrant information for an event, links for the
registrants appear on the next event, and users can click the links to autofill registrant information.
In the following screenshot, you can view the checkboxes and links that allow users to autofill
additional registrant information.
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In the following screenshot, you can see that in addition to the checkboxes and quick links that are
available on the first event, the next event also includes links for previously entered registrants. When
users click these links, registrant information autofills in the registrant's box.
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The user also selects applicable options for the event depending on the details you select to include
on the part. For example, if you select to include an event preference for dietary requirements, the user
may select vegetarian.

Step 3 Payment — On the third page of the event registration process, the program renders the
secure payment page on the Blackbaud server to process transactions for event registration payments.
When website users select multiple events with multiple charges, the total cost automatically defaults
on the secure payment page. For information about the secure payment page, refer to the Parts Guide.

Note: When you include free events on the part and a website user only registers for free events, this
page does not appear.
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When users submit event registrations, event transactions download into the BBIS Event Registration
Transaction Batch type in Blackbaud CRM. After you process transactions, event registration data
appears on the applicable records in Blackbaud CRM. For information about event registration
transactions and where data maps to in Blackbaud CRM, refer to the Web Transactions Guide.

Event Registration Form: Edit Part
When you design the new Event Registration Form part, you now configure each event's options in its
own configuration screen. You can enter text and HTML in the Description field and select Use event
capacity to limit the maximum number of registrations based on the event record’s capacity in
Blackbaud CRM. The Event price options grid includes new column headers and help text to clarify
what appears on the web page. You can also sort the event types in the order you want them to appear
on the page.
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Under Registrant options, you can expand each event type and select whether to let users register
additional guests as anonymous. You can also select and reorder biographical fields and additional
options that will appear on the registration page. In response to your feedback in the idea portal, the
part now also integrates with preferences from the event record in Blackbaud CRM. Event preferences
are listed with participant attributes under Additional options. In both grids, you can change the text
that displays in the Caption field. In the Include and Required columns, select which fields to display
and require for primary registrants and their guests.
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When you click Options, important options appear for the part such as how many people can be
registered in one web transaction and which constituent code to apply to registrants. You can also
select an appeal to associate with registration payments and specify whether to include a field for
additional donations on your registration page. In this section, you also select how you want free
events to appear on the page.
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When you create a new Event Registration Form or edit it, the Edit Part screen is condensed by the
event configuration screen and the Options link. This greatly enhances your ability to view the part so
you can quickly identify the area to make your changes.
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Appeal and Campaign Tracking for Events
On Event Registration Form parts, you can now select appeals from Blackbaud CRM to associate with
event registration payments. From the Design tab, under Options, a new section for Appeal tracking
displays.

Note: If an Event Registration Form part includes only free events, the Appeal tracking section is
grayed out.
To select an appeal, click the binoculars. Any appeals that are already associated with the event record
in Blackbaud CRM display on the search screen. You can also click Search to view and select from all
active appeals.
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Event registration payments are automatically associated with campaigns that have been added to the
event record in Blackbaud CRM. Within a BBIS Event Registration Transaction Batch in Blackbaud CRM,
you can now modify the appeals and campaigns that are associated with event registration payments.
When you review transaction details in an uncommitted batch, you can now click View appeal and
campaigns details on the Payment tab.

In the window that opens, you can select the Appeal or Campaigns tab to review and modify the
appeal and campaign selections for event registration payments prior to committing the batch.
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Directory Private EmailMessaging
An enhancement was made to the Directory part in Blackbaud Internet Solutions that now enables
alumni and other users to send messages to others in the directory without sharing their email
addresses. This functionality is available only for website users who are logged in to Blackbaud Internet
Solutions; anonymous users do not have the capability to use directory messaging.

Note: A website user can send a maximum of 10 messages per hour. When this limit is reached, a
message displays telling them to try again later.
On the Design tab of a Directory part, select Allow messaging between users to enable messaging.
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When you select this option, additional fields display below the option so you can configure the
message's default text, including the subject, email message, from address, from name, confirmation
message, and opt out message.
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Note: To avoid having the email rejected or considered spam, the From address must be an email
address on a domain that the organization owns and controls. This is necessary as some email
providers such as Yahoo and AOL have strict DMARC policies that reject any emails with a yahoo.com
or aol.com email address that have not originated from those domains.
When messaging is enabled, an email icon ( ) displays in the directory's Messaging column for
people who have a primary email address and have not opted out of messaging. To send a message,
click beside the recipient's name to display the message template. You can edit the message as
desired, then click Send message to send the email. The email is sent via the organization to the
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recipient, and the recipient's email address is not visible to the sender. A confirmation message
displays when the email is successfully sent.
The Communication Preferences form was also updated to support opting out of receiving email
messages sent from other directory users.

In Directory messages, select Opt-out to have a directory messaging opt-out checkbox display to
users on their Communication Preferencesform. You can also enter text in the Opt-out text field on
the Element tab to customize the text that displays for the option.
When users click the unsubscribe link in an email they receive via directory messaging, they are sent to
their Communication Preferences form where they can select the directory opt-out option. Users can
also clear this option if they had previously opted out and now want to resume directory messaging.

Communication Preferences Form
Enhancements
We've made some enhancements to the Communication Preferences form to provide functionality
improvements to email communication preferences.

New Email Address Selector Property
Previously, users had the option on the Communication Preferences form to specify which email
address they wanted to use to receive email communications. Because some customers prefer not to
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give users this choice, we've added the ability for administrators to disable the email selection option
globally for all email types.
Use the new Email address selector property on the Form tab to configure whether or not to allow
email address selection on the Communication Preferences form.

l Select No (default) if you do not want users to select an email address preference. The email
selector does not display on the Communication Preferences form and the users' primary email
address is used for all email communications.
Because Blackbaud Internet Solutions does not honor the email address preference, it is
recommended that if you use only Blackbaud Internet Solutions for email communications,
select No.

l Select Yes to allow users to select an email address preference. The email selector displays on
the Communication Preferences form.
Because Blackbaud Direct Marketing (BBDM) can honor the email address preference, it is
recommended that if you use only BBDM for email communications, select Yes to allow email
address selection.

Note: If you use both Blackbaud Internet Solutions and BBDM for email communications, it is
recommended that you select No for this option.

New Email Opt-in/Opt-out Preferences
In an effort to offer more explicit options for online users, the email preference settings in Blackbaud
Internet Solutions have been enhanced to specifically indicate whether users are opting in or opting
out of email communications, or if they have no preference either way.
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There are now three email preference options, Opt-in, Opt-out, and No preference, available for each
communication type. This gives users the option to explicitly opt out of receiving a certain email type.
Users who do not have a previously set choice in Blackbaud CRM will have their email preference
options set to No preference by default. They can subsequently modify these preference settings on
the Communication Preferences form and submit the changes.
You can use the Element tab to customize the text that displays to the users for each of the preference
options. You cannot leave the text field blank for these options.

l Opt-in: Default text is Send me these emails.
l Opt-out: Default text is Do not send me these emails.
l No preference: Default text is No preference set.

Global Opt-Out Confirmation Text
The global opt-out option allows users to opt out of all communication from your organization. We've
added the ability to include text for a confirmation message that displays in red beneath the global
opt-out option when users select it.
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On the Element tab, use the Global opt-out confirmation text property to specify the text you want
to display when users select the global opt-out option. The default text for the confirmation message
is You will not receive email from us. You can edit the text to customize your message or you can leave
this field blank if you do not want to display a confirmation message.

Updated reCAPTCHA
When you enable reCAPTCHA in Administration, Blackbaud Internet Solutions displays a completely
automated public Turing test to tell computers and humans apart (CAPTCHA). With CAPTCHA
functionality, the program can ensure a user is not an automated program to generate spam or phish
for payment information.
Previously, the program displayed distorted text that users were required to type into a box. To
simplify the experience, the program now displays a checkbox labeled "I'm not a robot." Users can
select the checkbox to proceed.

Note: In cases where the program cannot confidently predict whether a user is a human or an abusive
agent, it will display an additional test to confirm the user is valid. For example, the CAPTCHA may
display multiple images and ask the user to identify which images match a particular description.
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The reCAPTCHA options you select in Administration control all parts in Blackbaud Internet Solutions
except the Advanced Donation Form, Event Registration Form, and Payment 2.0 parts that use the
Blackbaud Secure Payments form. Those parts now include an Additional payment fields section on
the Design tab where you can select to include reCAPTCHA.

When you include this option, a reCAPTCHA checkbox displays below credit card payment fields on
your Blackbaud Secure Payments form. Users must select the reCAPTCHA checkbox before they can
submit the form.

Note: If your reCAPTCHA keys no longer work with the updated version, the site administrator can go
to http://www.google.com/recaptcha to obtain new public and private keys, and to register the site
domains.

URL Redirects
We've improved our URL redirect implementation to ensure that browser search engines correctly
handle your redirected pages.
Previously, when administrators added a new redirect to forward an http URL to an https URL, a 302
redirect was created. Since 302 redirects are considered temporary, this was causing issues with the
page indexing by Google's search engine.
Now, our modification to the redirect functionality creates 301 redirects, which are considered as
permanent page moves. Since search engines do not penalize 301 redirects like they do with other
types of redirects, your new URLs do not lose page ranks, positions in search engine results, or back
links to the original URLs.
To create a URL redirect, go to Administration > URL redirects, then click New redirect.
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Service Pack 12

Donation Form - Mini (Beta)
The Donation Form - Mini (Beta) part is our beta release of a new Blackbaud Internet Solutions
donation form that provides a new simplified checkout experience for campaign-based donations. The
form has a modern, responsive HTML design that automatically adjusts to the device size, such as a
smart phone or tablet, on which the page is being viewed.
This new form allows donors to make a quick, basic donation by selecting a predefined giving level or,
if configured, to enter their own gift amount. Because the form uses PCI-compliant Blackbaud
Checkout, customers can be assured that credit card and merchant account information is processed
and stored on a Blackbaud-hosted secure server.
Digital wallet options are available on the Donation Form - Mini (Beta) part for BBMS customers only.
Visa Checkout and Masterpass are automatically available to donors as secure checkout options. Both
support the same currencies as BBMS: USD, CAD, GBP, and EUR.
Apple Pay is now available to donors as a secure checkout option. Previously, this was only available for
organizations in the Apple Pay Early Adopter Program (EAP); now it is Generally Available.

Note: eReceipts are not supported with the Donation Form - Mini (Beta) part.

Note: The Donation Form - Mini (Beta) part is considered a proof of concept and will transform into a
full donation form in an upcoming Blackbaud Internet Solutions release.

Design the Form
Use the Design tab for the Donation Form - Mini (Beta) part to configure the form and customize it for
your organization.
In the Donation form message section, you can use the HTML editor to create a custom message to
display on the form or you can use the default message.
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In the Designation section, select the designation that you want associated with donations made using
this form. In the Appeal section, click Add appeal to search for and select the appeal that you want
associated with the donations made using this form.
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Note: The designation and appeal can be overridden by the URL used to access the donation form.
You format this URL as https://www.yourdomain.org/donate-now?aid=Appeal system record
ID&did=Designation system record ID.
You can find the appeal and designation system record IDs to include in the URL by creating an ad-
hoc query in Blackbaud CRM. In Analysis > Information Library, click Add an ad-hoc query on the
Queries tab. In the Select a Source View window, select Appeal in Record type and in Source view,
then click OK. In Select filter and output fields, select Appeal record and any other query criteria, and
add to Results fields to display. Click the Preview results tab. For the desired appeal, copy the
corresponding system record ID. This is what you'll use in the URL for the Appeal system record ID. To
locate the Designation system record ID, create another ad-hoc query and follow the steps above,
substituting Designation for Appeal.
Under Giving levels, you can set up suggested giving levels to display on the donation form. By
default, three best practices giving levels of $25, $100, and $500 are specified. You can change these
amounts, and add or remove giving levels as desired. There must be a minimum of one giving level on
the form. Optionally, you can include a name to display on the form for any of the giving levels, and
specify a giving level as the Default so it's preselected on the donation form.

You can also allow users to specify another gift amount by selecting the Allow other amount option,
then entering a Minimum gift amount that donors can contribute.
In Payment Setup, select the merchant account to use to process donation transactions.

Note: All merchant accounts support the Donation Form Mini - (Beta) part except for iATS and IP
Payments. iATS and IP Payments display as disabled in the Merchant account list.

The default confirmation message that displays to donors after their payment is made shows under
Confirmation Screen. You can customize this content according to your organization's needs. Note
that Amount, Designation, and Appeal are the only merge fields that can be displayed on the
confirmation screen.
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Optionally, under Additional payment fields, you can select to display a reCAPTCHA checkbox on your
Blackbaud Secure Payments form below the credit card payment fields. Users who are not logged in to
your site must select the reCAPTCHA checkbox and perform the reCAPTCHA challenge before they can
submit the form.

Use the Form
On your website, the Donation Form - Mini (Beta) part displays as shown in the example below.

Note: Due to the donation form's responsive design, it automatically adjusts to the device size on
which it is viewed and may look different than this example.
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Donors can select their donation amount or enter a different amount in Other, then click Donate Now.
They can then enter their billing address information in the checkout window.

Note: Donors using a digital wallet, such as Apple Pay, do not need to enter billing information.
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Warning: Your code tables in Blackbaud CRM for countries and their subdivisions, such as states and
provinces, must follow the International Organization for Standardization’s ISO 3166 standards. The
secure payment page uses ISO 3166-1 for countries and ISO 3166-2 for subdivisions such as states. If
your code tables do not match these standards, Blackbaud Checkout changes selections to the closest
abbreviation when it processes transactions, and this can lead to incorrect address information. For
example, if your countries table includes “United Kingdom,” the secure payment page changes this to
the United States abbreviation “US” because it is the closest abbreviation to “Un.” In ISO 3166-1, the
abbreviation for the United Kingdom is “GB,” and your code table must match this. For information
about how to edit your code tables in Blackbaud CRM for countries and their subdivisions, see the
Administration Guide.
After donors click Continue to payment, they can enter their payment information.
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The name entered in the Name on card field is used to match to an existing constituent record or to
create a new constituent record.

Note: The fields on the secure billing and payment screens display as shown and cannot be
customized.
When donors click Complete payment, the confirmation screen displays.
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Set up Apple Pay for Blackbaud Checkout
With the Donation Form - Mini (Beta) part, you can now accept payments through Apple Pay when you
use Blackbaud Merchant Services (BBMS) to process one-time credit card donations. This new
payment option allows your constituents on Apple devices to make donations without having to enter
as much information on the donation form, because data such as their credit card number and billing
address are already stored in their Apple Pay wallet.
Apple Pay is now available to donors as a secure checkout option for BBMS customers in the U.S.
Previously, this was only available for organizations in the Apple Pay Early Adopter Program (EAP); now
it is Generally Available.

To get approved to use Apple Pay
• Complete the request for information form on Blackbaud's website. A Blackbaud representative

will contact you to confirm we have completed enablement of Apple Pay for use with your
Blackbaud Merchant Services account.
If you do not yet have a Blackbaud Merchant Services account, a representative can assist in
setting up an account for you.

Note: Please be aware that the onboarding process for setting up Apple Pay may take several weeks.
In the meantime, your organization doesn't have to wait to start using the Donation Form - Mini
(Beta). You can still configure the form and use it for taking donations using credit cards, Visa
Checkout, and Masterpass.
Once the onboarding process is completed, Apple Pay will automatically display as an additional
payment option on the checkout screen for donors who are using an Apple Pay-enabled environment.
All transactions are processed via BBMS.

Note: Ensure you select your BBMS merchant account in the Merchant account field on the Donation
Form - Mini (Beta) part.

Note: Refer to Apple's Terms and Conditions in the Blackbaud Checkout FAQs.
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Event Registration Form: Register as an
Organization
We've added new functionality to the Event Registration Form that allows website users to register as
an organization so they can make multiple ticket purchases for the same event. The organization can
indicate who is attending the event or purchase tickets for unknown guests. In Blackbaud CRM, the
payment for the event is tied to the organization.
You can configure the Event Registration form to enable this feature. On the Design tab, click Options.
Under Organization options, select Allow individual to register on behalf of organization, then
select the fields to appear on the registration page. As with the individual biographical fields, you can
alter field captions and select which fields are required. The Organization Name field is always
displayed by default and is required.

On the Step 1 Selection page of the Event Registration Form, after website users select the events they
want to attend, they can optionally select to register as an organization.
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When users select Register as organization, the Step 2 Registration page displays with the
Organization information fields that were configured on the Event Registration Form part.
If users forget to register as an organization on the Step 1 Selection page, they can click Register as
an organization? at the top of the Step 2 Registration page and the applicable organization
registration fields appear on the page.
Users can click Register as individual? if they did not intend to register as an organization on the Step
1 Selection page.
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In the corresponding batch in Blackbaud CRM, two new columns are included for the organization:
Organization name and Linked organization auto-match. In Web Transactions > Configure
Integration, on the Auto-match tab, you can specify matching criteria for the batch to auto-match and
update the Linked organization auto-match column. After you commit the batch, the Registrations
tab on the Event record displays the organization record.

Batch Separation for Event Registrations
We've added the ability for you to split incoming event registration information from your Blackbaud
Internet Solutions website into separate batches in Blackbaud CRM. Constituent updates and additional
revenue information can be split into different batches that are separate from the event registration
transaction batch. This enables an event administrator to manage the event information in a timely
manner, and have the constituent updates and additional revenue information reviewed and
committed by the appropriate departments.

Note: This batch separation capability is applicable to transactions made using the Event Registration
Form and the Event Registration Form (Classic) parts.
To configure the separate batch assignments in Blackbaud CRM, click the Batch Assignment Settings
tab on the Web Transactions page. Select the event registration transaction batch you want to split,
then click Edit. On the Edit batch assignment settings screen, you can either click Add in Batch options
to create a new batch assignment, or select a batch assignment and click Edit to update an existing
batch assignment.
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On the Add/Edit batch assignment screen, you can specify one or both batch separation options. Select
Separate constituent updates into different batch to have any constituent update coming in with an
event registration for a registrant separated into a different profile update batch. Select Separate
additional revenue into different batch to have any additional revenue coming in with an event
registration separated into a different enhanced revenue batch. When you select either of these
options, the Batch template and Batch owners fields display so you can specify the corresponding
template type and owner for each batch. By default, a batch assignment setup is provided.
When you review the event registration batch transaction details before committing the batch, you'll
notice some fields do not display. If additional revenue is found, the Additional Donation tab is no
longer shown. If a constituent match is found or if a guest is matched to a Linked Constituent, the
Process column checkboxes are not displayed on the Biographical and Address tabs.
When the batch is committed, biographical and address updates for registrants and linked guests are
written to the separate BBIS Profile Update Transaction Batch. For additional revenue updates,
registrant information (constituent name, additional donation amount, designation, appeal, and
campaign) is written to the separate Enhanced Revenue Batch.

Note: The batch separation only splits constituent updates into the BBIS Profile Update Transaction
Batch when the incoming registrant is matched to an existing Blackbaud CRM constituent record. If
the registrant does not exist in Blackbaud CRM, a new constituent record has to be created, and so
the information is written by theEvent Registration Batch.

Service Pack 13

Directory Private Email Messaging for
Anonymous Users
We've enhanced the Directory Private Email Messaging functionality so that anonymous users can send
private messages. Alumni and other users now have the ability to send messages to others in the
directory without having to log in to Blackbaud Internet Solutions.
Before you configure a directory part to allow anonymous users to send messages, make sure that
reCAPTCHA is enabled on your site in Administrator > Sites & settings. See reCAPTCHA settings for
information on configuring reCAPTCHA.
On the Design tab of a Directory part, select Allow users who are not logged in to send messages
under Messaging Fields to enable anonymous messaging. This option is available only when Allow
messaging between users is selected.
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Note: You can configure a Directory Messaging Opt-out element on the Communication Preferences
form to enable users to opt-out of directory messaging.
When messaging is enabled, the Send a message icon displays in the directory's Messaging
column for people who have a valid email address in Blackbaud CRM and have not opted out of
messaging. Anonymous users can click the icon to display the default email message, which can be
edited as desired. The Default subject, First Name, Last Name, and From email address fields are
required. The From email address is the default Reply to address when the recipient replies to the
message.

Note: An anonymous user can send a maximum of 10 messages per hour. When this limit is reached,
a message displays telling them to try again later.
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When the user clicks Send message, the email is sent via the organization to the recipient, and the
recipient's email address is not visible to the sender. A confirmation message displays when the email
is successfully sent.

Upgraded HTML Editor in Email Messages and
Templates
Blackbaud Internet Solutions provides a powerful HTML editor to allow you to format and lay out
content. With the HTML editor, you can update content easily and safely while you maintain control
over the design and content. In this release, we've upgraded the HTML editor used for creating email
messages and email templates to the most recent version (TinyMCE version 4).
One of the most important benefits of this upgrade is that the editor now includes the HTML <head>
tag that's necessary for creating responsive design. With responsive design, your emails display
optimally on any device — desktop, tablet, or smartphone.
The previous version of our HTML editor removed the <head> tag from the source code, which
prevented you from creating emails with a responsive design. This new version of the HTML editor
automatically adds the <head> tag in the HTML source code, where you can include elements such as
scripts, styles, and meta information.

Note: For this release, we've updated the HTML editor only for email templates and email messages.
Upgrades to the HTML editor used in other parts of Blackbaud Internet Solutions are planned to be
phased in as part of our upcoming releases.
Another difference between the upgraded HTML editor and the previous version is how the
functionality is organized. In the previous version, there were separate tabs — Formatting, Insert,
View, and Image — as shown below. There was also a Table tab that displayed when a table was
selected in the editor.

In the upgraded version, the HTML editor functionality is now organized into three drop-down menus
— Insert, View, and Table — and a toolbar.

SERVICE PACK NEW FEATURES 94



The toolbar includes all the same functionality that was previously located on the Formatting tab. You
can hover over each toolbar icon to see its description.
The Insert, View, and Table menus include the functionality that was previously located on the Insert,
View, and Table tabs. Note that the Table menu items are not enabled unless you have a table
selected in the HTML editor.
When you click anywhere in a table, a toolbar with commonly used table operations — Table
properties, Delete table, Insert row before, Insert row after, Delete row, Insert column before,
Insert column after, and Delete column — displays in the HTML editor adjacent to the table. These
table operations, along with additional ones, are also included in the Table menu.

Functionality previously located on the Image tab is now accessed from the toolbar. Click Insert/Edit
image to display the Insert/Edit Image window. Here you can select an image to add to your email
message or template, and modify the image's appearance and properties.
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You can include scripts, styles, and meta tags in your email message or template using the <head> tag.
On the View menu, click Source code, add your own code as needed in the <head> tag, then click Ok
to save.
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You can also specify document properties — Title, Keywords, Description, Robots, and Author —
that will be included in the <head> tag as meta data. Click on the toolbar to display the Document
Properties window. The data you enter in the document property fields is saved as meta data inside
the <head> tag.
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While the document property fields may not be as important to email messages and email templates,
they'll have more significance once the HTML editor is upgraded for other Blackbaud Internet
Solutions parts, such as the Formatted Text and Images part, the Donation Acknowledgment part, and
the Event Acknowledgment part.

Sample Responsive Email Templates
To maintain consistency with industry standards for fully responsive emails, we're providing three
generic responsive email templates that you can download from the Blackbaud Community. After
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downloading these templates, you can use them in Blackbaud Internet Solutions as default templates
from which you can create your own responsive emails for acknowledgments, appeals, and newsletters.
For detailed information about these templates, including how to download and use them in
Blackbaud Internet Solutions, see the Responsive Email in BBIS blog post in Blackbaud Community.

Support for SVG Image Files
Blackbaud Internet Solutions now supports the Scalable Vector Graphics (SVG) image file format. The
SVG format enables your images to display optimally when used in responsive web design, because
they retain their quality when they're resized. You can upload SVG images into the Image library and
the File library from Site explorer. After you upload the images, you can use them on your Blackbaud
Internet Solutions website.
SVG is a vector-based image format used for two-dimensional graphics included in websites. SVG
images and their behaviors (such as scalability) are defined in XML. To view or edit the image
attributes, open the SVG file in any text editor (such as Notepad); the image definition is located within
the <svg> tag. Refer to your preferred XML markup reference material for more detailed information
about editing the SVG image attributes.

Usability Enhancements for Developer Parts
We've enhanced the code entry sections of several parts — Style Sheets, Unformatted Text, and
Custom Content — to make the development process easier. We've improved the code editor
functionality so it's easier to create and edit code directly in these Blackbaud Internet Solutions parts.
Previously, many users had to write and troubleshoot the code in a different application, and then copy
the code back into the Blackbaud Internet Solutions parts, which made the process time-consuming.
One of the enhancements we made was to add line numbers to the code entry display. This enables
you to locate code more easily.
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We also included four new buttons — Undo, Repeat, Go to, and Maximize — to enable you to
perform common editing actions.

In addition, we added an Apply button on the Unformatted Text editor. This enables you to save your
work and continue editing without having to close the part and reopen it.
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eStore Functionality: Notice of Deprecation
Blackbaud will no longer sell the eStore part of Blackbaud Internet Solutions to new clients. While
eStore will continue to be available to Blackbaud Internet Solutions clients that already own eStore,
starting in Q1 of 2018, Blackbaud will no longer develop eStore beyond critical security maintenance.
Clients that are interested in exploring alternative solutions to address their eStore needs should
contact their account executives for more information.

Service Pack 14

Redesigned Event Registration Form for
Complex Events
This service pack includes a redesigned Event Registration Form part that supports complex events —
such as multi-day events or when there are multiple events on the registration form. The Event
Registration form has a new user interface and a streamlined workflow to make the registration
process easier especially when registering multiple attendees for multiple events.

Note: One major workflow change is that the attendee registration page displays before the list of
events is shown. It is assumed that users will have already seen the list of events before they access
the Event Registration Form. When creating an event, our recommendation is that you link users to
the registration form at the point that you want users to start their registration.
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Event Registration Form: Website
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When you include the Event Registration Form part on your website, users can now register multiple
attendees for multiple events using the streamlined workflow steps:
Step 1: Attendees — Website users can enter details for all registrants, including themselves, multiple
guests, and unnamed guests, who will be attending any of the events. When configuring the form, you
can specify which fields to display — and which fields are required — on the Attendees page.
Step 2: Select events — Shows a list of all events that are available to register for. When selecting an
event to attend, website users can select attendees from a drop-down list populated with all attendees
that were added in Step 1. As attendees are registered for events, the page is automatically updated
with event attendee information and subtotal amounts.
Step 3: Select options — Website users can choose options (where applicable) for events, such as
preferences and restrictions, for each registrant for each event. Note that event options cannot be
selected for unnamed guests.

Note: The Select options page doesn't display if there are no options available for the selected
events.
Step 4: Review — Displays details for the selected events, such as who is registered for each event and
what their preferences are. Modifications can be made to any event registration by selecting the
event's link. When designing the form, you can configure whether this page displays to the website
user.
Step 5: Checkout — Website users can specify the billing information, additional donations, and the
payment method, then make a payment using Blackbaud Checkout.
Once the registration is complete, the transaction data in Blackbaud CRM includes information for each
registrant, including event details and options, and payment information.

Event Registration Form: Edit Part
Note: We've used new CSS classes to support the user interface redesign. If your organization
currently uses a custom CSS on your event registration forms, you should plan for additional design
work in order to incorporate our new form design into your existing site style.
When you design the new Event Registration Form part, you select multiple events to include on a
single form. Select Add an event to choose an event from Blackbaud CRM and specify the event's
configuration options. All events listed under Add events display on the Select events page of the
Event Registration Form in chronological order. The events are automatically ordered on the form
based on their start date and time, so you no longer have the ability to manually reorder events.
Under Actions, you can edit or remove events as needed. Optionally, you can also enter text in Title if
you want to include an event description on the form for the main multi-level event.
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The registrant biographical fields that display on the Attendees page are now configured using the
new Field entry options section under Attendee options. In the Include and Required columns,
select which fields to display and which fields are required for hosts (primary registrants) and their
guests. You can also modify the text that displays in the Caption field and change the order that the
fields will display on the form. Under Organization options, you can select whether to allow users to
register as an organization; if selected, the option displays on the Billing Information page prior to
payment.
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Under Options, a new Include review step option enables you to configure whether the review page
is displayed to website users during the registration process.
To provide more summary information to users after they've registered for events, we've added a new
Event merge field called Full Event Details that you can use when customizing the acknowledgment
page. When you include this merge field, all the information from the registration form's Review page
displays on the acknowledgment page when registration is completed.

Event Registration Batch Processing User
Interface Enhancements
To support our redesigned Event Registration Form part, we've also redesigned the batch processing
to better accommodate multiple event registration results. Now, when you review the downloaded
event registration batch details in Blackbaud CRM, the information for registrants and events is
organized more efficiently.
We removed the Guest tab, and now all registered attendees — host, guests, and unnamed guests —
display on the Registrants tab. The Registrations tab shows details for all events that have been
registered for. The Payment tab shows all payment information that was entered on the payment page
during registration. The donation amount and designation are shown on the Additional donation tab
if an additional donation was made during the checkout process.
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When you select an attendee on the Registrants tab and then select View details, all corresponding
event information is displayed. The Events tab lists all the events that the attendee was registered for,
the Options tab shows the preferences selected for each event for the attendee, and the Biographical
and Address tabs show the registrant's personal information.

Enhanced Communication Consent Support
The General Data Protection Regulation (GDPR) is an EU law that will be enforceable from 25th May
2018, and in the UK will replace the aging Data Protection Act. It is designed to both strengthen and
harmonize data protection across EU member states, and is directly applicable to all organizations
‘established’ in the EU, irrespective of whether the actual data processing takes place in the EU or not.
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Even if not established in an EU country, certain organizations with substantial activities in the EU will
need to comply with GDPR. Please refer to our infographic Could You Be Subject to GDPR? for further
guidance on whether or not GDPR may apply to your organization. Such organizations that are subject
to GDPR and collect, store or process personal data must comply with GDPR’s Data Protection
Principles and other conditions of processing. New obligations on data controllers include expanded
data subject rights, mandatory data breach notification, an enhanced focus on accountability and the
appointment of Data Protection Officers. Personal data must still be processed fairly and lawfully,
justified by one of six legal bases that have remained substantially similar between the Data Protection
Act and GDPR, including with the data subject’s consent. Arguably the most significant change,
however, is the requirement that a data subject’s consent to process their data must now be
‘unambiguous’ and given via a ‘clear, affirmative action’. The penalties are also set to change, standing
at a maximum of €20,000,000 or 4% of global revenue; whichever is higher. For a more in depth
discussion of GDPR’s operational effects, please read Blackbaud’s datasheet Important Impacts of
GDPR. Undoubtedly, therefore, GDPR requires organizations processing personal data to implement
significant operational reform. Blackbaud has designed the following solution functionality to assist
our customers in achieving this reform.
In order to support the upcoming enactment of GDPR, functionality was added in this release to
ensure organizations capture explicit consent from their constituents before communicating with
those constituents by any channel, such as mail, email, or phone.
To support GDPR, a new consent solicit code type was added in Blackbaud CRM. When a constituent's
consent is received, preference information and related details for the consent solicit codes are
included on the constituent's record on the Communication > Preferences tab. In Blackbaud Internet
Solutions, several changes were made to the Communication Preferences form to support the new
consent solicit codes.
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Email Opt-out
In this release, we've renamed the previous the Global opt-out option to Email opt-out to more
accurately reflect the functionality and meet global email opt-out regulations for those customers who
continue to use solicit codes.

Consent Solicit Codes
The new Consent solicit codes element lists consent solicit code options, enabling constituents to
explicitly opt-in or opt-out of a specific communication channel. You can configure which consent
solicit codes to include on the form by using the Element tab in the Properties pane. Select Advanced
properties, then specify the consent solicit codes from Blackbaud CRM you want to include on the
form, the text to display for each code, and which codes require a consent selection.

General Correspondence
On the General correspondence element, the No preference option has been removed. Previously,
constituents who did not have a previously set choice in Blackbaud CRM had their email preference
options set to No preference by default. Now, if constituents do not specify a preference to opt-in or
opt-out, the message "A preference has not been selected" displays on the form. To change the
message, modify the text in the No preference text row on the Elements tab.

Privacy Policy
The new Privacy policy element enables constituents to review your organization's privacy policy from
the Communication Preferences form. You can select the privacy policy to include by using the
Element tab in the Properties pane. Select Advanced properties, then either select the Blackbaud
Internet Solutions web page or enter the URL where the privacy policy is located. On the Elements tab,
you can also modify the text in the Header text row to change the header caption, and in the Privacy
policy text row to change the link display text.

Blackbaud CRM Integration
When constituents submit their consent preferences via the Communication Preferences form, those
preferences are written to their Blackbaud CRM constituent record and display on the
Communications > Preferences tab under Solicit codes. Consent solicit codes, consent statement,
privacy policy, and more consent details are included on the record.
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Two new settings — Do not email consent solicit code and Consent solicit code source— were
added in Blackbaud CRM under Manage web transactions, Configure integration. You'll need to
configure these settings before you can start capturing the consent solicit codes on the
Communication Preferences form.

Similar to the Do not email solicit code setting, the new Do not email consent solicit
codeconfiguration setting allows you to identify one of your consent solicit codes to use as your
global email opt-out value. A global email opt-out value is required by Blackbaud to comply with
international email compliance, including CAN-SPAM, CASL, and GDPR.
The Consent solicit code source setting is written to the solicit code record when new values are
added from the Blackbaud Internet Solutions Communication Preferences form.

Sample Responsive Email Templates
In Blackbaud Internet Solutions SP13, we provided three generic responsive email templates that you
could download from the Blackbaud Community, and then use in Blackbaud Internet Solutions as
default templates. For this release, we've made these email templates available on the BBIS Developer
site, and included a link to them from within Email Templates.
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There are currently three sample responsive email templates available for download. You can use these
sample templates to create your own responsive email messages for acknowledgments, appeals, and
newsletters. To use these templates, go to the BBIS developer site under Responsive Email Templates
to download the source code and review the instructions for creating a new email template in
Blackbaud Internet Solutions.
Also in this release, we've removed the outdated placeholder, mobile-friendly templates from Email
Templates.

Service Pack 15

Communication Consent Part
To enable you to easily capture communication consent on your Blackbaud Internet Solutions forms —
and to assist with General Data Protection Regulation (GDPR) compliance — we've implemented a new
Communication Consent part. Your organization can use this new part to collect explicit consent from
users — both in the European Union (EU) and elsewhere — for how they want to receive
communication from you. In order for any non-profit organization to contact constituents residing in
the EU, they must have explicit opt-in consent for any kind of communication via any channel — such
as email, phone, SMS, or mail.
As an organization, you can create one Communication Consent part — or multiple versions of the part
— to support the forms in Blackbaud Internet Solutions that collect constituent information and write
the data to constituent records in Blackbaud CRM.
With this new functionality, you can include a Communication Consent part on any of the following
forms in Blackbaud Internet Solutions:

l Donation Form
l Event Registration Form (Classic)
l Events Registration Form
l User Login Form
l Payment 2.0 Form

Note: This form supports consent for all transactions types — donations, event registrations,
memberships, and sponsorships.

l Advanced Donation Form
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When users submit the form, their constituent record is updated on the Communications >
Preferences tab in Blackbaud CRM with their communication consent preferences.

Design the part
Use the Design tab for the Communication Consent part to configure the part and customize it for
your organization.

Under General, you can customize the title to display on the web page for the communication consent
preferences or you can use the default title. You can also include customized instructions under
Consent Statement or use the default statement.
Under Consent Options, add the consent options you want to display on the web page. Select Add
Option to search for solicit codes or consent solicit codes that are configured in Blackbaud CRM, then
choose the ones to include on the form. For each consent option, you can modify the caption that
displays on the form, specify whether the option is required, or remove the option. Optionally, you can
add a divider to separate sections on the form — for example, to keep all email consent options
together — by selecting Add Separator and include a caption for the separator. You can click and
drag the consent options to reorder them and to move the corresponding separators.
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Under Privacy Policy, select an option for including access to your organization's privacy policy on the
web page. Select Create link to Blackbaud Internet Solutions page to choose an existing page on
your website. Select URL to specify the web page where the privacy policy is located. If you don't want
to include a link, select None.

Add the part to a form
You can add a Communication Consent part to a form by configuring the Consent section on the
form's Design tab.

Under Consent part, select a saved Communication Consent part to include on the form, then specify
how you want the consent options to display.
Depending on your organization's site design or how your forms are styled, you can select whether to
use the inline option or the overlay option to gather consent.
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The Inline option includes the communication consent options embedded directly in the form itself.
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The Overlay option displays a pop-up window with the consent options when the form is submitted.

After users submit the form, their consent information is downloaded along with their transaction.
After the appropriate batch is committed, their constituent record is updated on the Communications
> Preferences tab in Blackbaud CRM with their communication consent preferences.

Note: You can expect a lag time of approximately 5 minutes between the time you commit a
donation or membership transaction batch and the time the consent preferences are written to the
constituent's record in Blackbaud CRM.
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After a user has already provided consent preferences, if they fill out a subsequent form that includes
the Communication Consent part and they are logged into Blackbaud Internet Solutions, their consent
preferences are automatically pre-populated. Users can modify their consent preferences, and the
changes are then written to their constituent record when they submit the form.
If a transaction is canceled for any reason, the user's consent preference selections for that transaction
are not written to their constituent record.

Communication Preferences Form
Enhancements
To support more configuration flexibility, we've made several enhancements to the Communication
Preferences form to improve how you can configure the form to capture user consent.
Previously, you could only include one element per type on the form. After an element was added, it
was grayed out in the Add fields list so that it couldn't be added again. With this enhancement, you
can now add multiple instances of the same element type to the form — for example, you can add
more than one Consent solicit codes element. However, each element of the same type on the form
must have different properties. Under Advanced properties, when you add a property for an element,
that property cannot be added again to the same element type on the same form.
In addition, we've changed the default Opt-in text and Opt-out text for the preference options to Opt-
in and Opt-out, respectively. Also, the No preference message text now displays directly below the
option name when no selection has been made.

When constituents submit their consent preferences via the Communication Preferences form, those
preferences are written immediately to their Blackbaud CRM constituent record and display on the
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Communications > Preferences tab under Solicit codes. Consent solicit codes, consent statement,
privacy policy, and more consent details are included on the record.

Service Pack 16

Acquisition Form Part
The new Acquisition Form part enables your organization to collect constituent information —
personal data, constituent attribute information, and communication consent preferences — without
requiring constituents to register or log in to your site. You can then download the data to your
constituent database in Blackbaud CRM via the Constituent Update Batch process.

Note: Consider using the new Acquisition Form part — instead of the Email Signup Form — to
capture email signups going forward. The Email Signup Form will be deprecated in a future release.
Use the Design tab to configure the form and customize it for your organization. Under General
Properties, enter a Form Title that will display to web site users — for example, Join Our Mailing List.
You can also add a Form Description that displays below the form title to provide more information.
Under Fields, enter a Title for the fields section that displays on the form, and then select which fields
to include and whether they are required. The minimum required fields — Last Name and Email
Address — are selected by default and cannot be modified.
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You can change the order in which the fields display on the form by selecting the field's row and
dragging up or down in the list.
Under Attributes, enter a Title for the constituent attributes section that displays on the form. Then,
select which constituent attributes from Blackbaud CRM to Include on the form and whether they are
Required fields. Typically, you display attributes when you have multiple options and you want users
to subscribe to emails that match their preferences. Constituent attributes are not required to
configure the form, but is recommended to comply with email opt-in best practices.

Note: Only those constituent attributes you enabled in Sites & settings that have a type of Yes/No,
Table, and Text are available to display on the form.
Under Consent, to enable users to specify their consent preferences for how they want to receive
communication from your organization, choose an existing Consent part to include on the form. You
can specify how you want the consent preference options to display — choose Inline to embed the
options directly in the form itself or choose Overlay to display a pop-up window with the consent
options when the form is submitted.

To ensure users are not automated programs to generate spam or phish for information, select Enable
reCAPTCHA login to display reCAPTCHA on the Acquisition Form. You can also optionally specify a
Constituent Code from Blackbaud CRM to apply to users who sign up using the form.
Under Navigation, select the web page to display to users when the form is completed. Select the
binoculars to display the list of pages on your site to choose from. This field is required.
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As a last step, select Acknowledgment Email to configure the confirmation email to display after users
submit the form. The Name of email, Subject, From address, and From name fields are required. You
can edit the default text for the email message.
Here's an example of how the Acquisition Form displays on your website:

To enable you to download transactions from the new Acquisition Form, we've made some
enhancements in Blackbaud CRM for batch assignments. The Signup transaction type is now called
Signup/Acquisition, and there is a new Acquisition transaction type. So, you can choose which
transactions — either Signup, Acquisition, or both — to include in the batch assignment.
Transactions from the Acquisition Form are downloaded to the Constituent Update Batch. When you
commit the batch, data captured on the Acquisition Form is written to the constituent's record — the
record is created for new constituents and updated for existing constituents.
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Note: Any existing Signup batch will have its Transaction type automatically changed to
Signup/Acquisition and its Include transaction type option set to Signup by default. You can edit
any of these batch assignments to also include the Acquisition transaction type.

Service Pack 17

Event Registration Form Enhancements
To streamline the user experience when registering for a single event on the Event Registration form,
we've added the following enhancements to the form.

Single events with one ticket type
When there's only one event configured on the Event Registration form — and there's only one ticket
type — the number of attendees is automatically pre-populated for the ticket type. This enables the
registrant to quickly proceed through the registration process for a single event without having to
manually enter information.
In addition, because selecting events is not necessary when registering for a single event with one
ticket type, the Select events tab doesn't display. Each attendee is automatically registered for the
single event.

Single events with multiple ticket types
When there's only one event configured on the Event Registration form — and there are multiple
ticket types — the Select events tab still displays but is used only to select the ticket type of each
attendee.
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First attendee automatically selected as host on Checkout page
To save registrants mouse-clicks when specifying billing information for an event, the first named
attendee displayed on the Attendees page is now automatically listed as the host on the Checkout
page.
With this enhancement, Blackbaud Internet Solutions assumes that the first attendee is paying for the
event, and pre-populates that person's contact information for billing on the Checkout page.

You still have the option to select a different attendee as the host from the drop-down list of
attendees. If the host is not attending the event —but is being billed for it — you can select Click here
to clear the form, then enter the host's contact information.

Note: An unnamed attendee cannot be recognized as a host.

Total amount due added to top of Checkout page
To enable registrants to view the total amount due for events without having to scroll down on the
Checkout page, the Total due amount is now shown both at the top and at the bottom of the page.
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Ability to include event information on the form
To enable you to provide users with introductory text about a single event directly on the Event
Registration form, we've added a WYSIWYG editor to the part's Design tab. Now, you can include
event information — using event merge fields or by creating custom content — at the top of the Event
Registration form.
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On the Design tab for the Event Registration form part, there's a new Event introductory text section.
You can use this WSIWYG editor to specify information to include at the top of the form. By default,
the merge fields EventName, Event Description, Event Location, Event Date, and Event Price are
included. You can apply styling, add additional custom content, or remove any of the merge fields.
The introductory text displays to users at the top of Event Registration form above the registration
steps.
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Support for Advanced Consent Solicit Codes
Blackbaud CRM has added a new Advanced Consent solicit code type which is similar to the EU
Consent solicit code type, but is more applicable for non-EU customers. To support this new code
type and enable you to collect Advanced Consent solicit codes configured in Blackbaud CRM, we've
made several enhancements to the Communication Preferences form.

New Advanced consent solicit codes element
The new Advanced consent solicit codes element lists advanced consent solicit code options,
enabling constituents to explicitly opt-in or opt-out of a specific communication channel. You can
configure which advanced consent solicit codes to include on the form by using the Element tab in the
Properties pane. Select Advanced properties, then specify the advanced consent solicit codes from
Blackbaud CRM you want to include on the form, the text to display for each code, and which codes
require a consent selection.
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Consent solicit code element renamed
In this release, we've renamed the previous Consent solicit code element to EU consent solicit codes
to be consistent with the solicit code's naming convention used in Blackbaud CRM.

Email opt-out element
With this release, you can now select any solicit code, consent solicit code, or advanced consent solicit
code to use for the global Email opt-out element.

Note: The Solicit codes, EU consent solicit codes, and Advanced consent solicit codes elements are
only available to include on the Communication Preferences form if there are corresponding solicit
code types configured in Blackbaud CRM.

Consent Data written to Enhanced Revenue
Batch
To provide consistency with the consent solicit code functionality in the Constituent Update Batch,
consent information collected from donation transactions in Blackbaud Internet Solutions is now
written to Blackbaud CRM through the Enhanced Revenue Batch.
Blackbaud CRM has added solicit code batch support — similar to the solicit code functionality in the
Constituent Update Batch — to the Enhanced Revenue Batch. Previously, consent information from
donations was written into a Blackbaud CRM constituent record as a business process. With this
enhancement, consent preferences specified in Blackbaud Internet Solutions donation transactions on
the Advanced Donation form, Donation form, and Payment 2.0 part are now included in the Enhanced
Revenue Batch. Once the batch is committed, the consent preferences are written to the constituent
records in Blackbaud CRM.

Custom Validation for Direct Debit Payment
Fields
To resolve issues with direct debit validation for countries other than the United States and Canada,
we've made enhancements to the direct debit validation on the Donation Form and Payment 2.0 Form.
Previously, the routing number field only validated 9-character US/Canada routing numbers, which was
causing issues for BSB, SEPA, and other banking types that have other character validation
requirements.
Now, with this enhancement, direct debit payment fields are labeled using the captions set in
Blackbaud CRM Banking Systems, and are driven by the banking systems enabled for your organization.
A new Banking System Type field enables donors to select another banking type — if more than one
banking system type is enabled in Blackbaud CRM, or if Australia is selected as the donor country
together with the USA banking system. The Routing Number field name changes to reflect the
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selected banking type. For example, if BSB is the selected banking type, the Routing Number field
displays as BSB Number. The information users enter in this field is then correctly validated in
accordance with the selected banking type.

Service Pack 18

New Frequency for Recurring Gifts
You can now schedule recurring gifts with the new Every 4 weeks frequency. When you add or edit a
recurring gift, you can choose this frequency and the gift will be processed every 4 weeks exactly,
which allows you to collect a 13th installment. This new frequency option is supported on the
following parts: 

l Donation Form
l Advanced Donation Form
l Transaction Manager

One benefit of the new frequency is that it enables donors to schedule an additional installment per
year. Previously, donors could select the Monthly option, which allowed for a maximum of 12 gift
installments per year. The new Every 4 weeks frequency option enables users to schedule another
installment — for a maximum of 13 — per year.
As with other recurring gift frequencies, the Every 4 weeks installment frequency information from
donation transactions on these forms in Blackbaud Internet Solutions is downloaded and written to
Blackbaud CRM through the Enhanced Revenue Batch.

Configure the Donation Form
On the Design tab under Donor gift scheduling options, select Allow recurring gifts to display the
recurring gift options.
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l When you select General, donors can determine the frequency of the recurring gift. On the
Donation Form, they'll now be able to select a giving frequency of Every 4 weeks. When they
choose this option, donors are required to enter a start date for the recurring gift.

l When you select Specific, you define the recurring gift schedules donors can choose. You can
now select to include Every 4 weeks as the frequency.

Note: You can modify the Every 4 weeks caption text on the Language tab under the Recurrence
Frequency category.

Configure the Advanced Donation Form
When creating your custom donation experience using the Advanced Donation Form part, you can now
include HTML for a frequency option value of Every 4 weeks for recurring gifts. For more information
about designing the form, see the Advanced Donation Form Developer Guide.

Configure the Transaction Manager
On the Design tab under Recurring gift updates, select Allow frequency updates to display the
recurring gift options.
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l When you select General, donors can determine the schedule for their recurring gift payment.
On the Transaction Manager, donors can now select a giving frequency of Every 4 weeks when
making changes to their recurring gift. When they choose this option, donors are required to
enter a start date for the recurring gift.

l When you select Specific, you define recurring gift schedules for donors to select from. You can
now select to include Every 4 weeks as the frequency.

Note: You can modify the Every 4 weeks caption text on the Language tab under the Recurrence
Frequency category.

Concurrent Sessions
Blackbaud Internet Solutions now displays the total number of concurrent active sessions for users with
administrative rights. An active session is defined as a login from a unique IP address. For example, if
you are logged into Blackbaud Internet Solutions from your work computer and from your home
computer at the same time, the display will show that there are 2 active sessions. Logins from multiple
browsers on the same computer are not considered as separate active sessions.
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Donation Form is now WCAG 2.0 AA Compliant
In our ongoing effort to ensure Blackbaud Internet Solutions commonly-used parts meet accessibility
standards, we're pleased to announce that the Donation Form part now meets the Web Content
Accessibility Guidelines (WCAG) 2.0 level AA compliance guidelines.

reCAPTCHA Key Validation
To resolve integration issues with Blackbaud Internet Solutions that resulted from updates to
reCAPTCHA, we've added the ability for administrators to validate their reCAPTCHA keys.
In Administration, Sites & settings, under reCAPTCHA, you can now verify that the public and private
keys that you enter are correct. After you configure or update the keys, click the Validate button. The
reCAPTCHA challenge displays, and once you've completed the challenge, a message displays to let
you know whether or not the keys are valid.

jQuery Version Upgrade
With this release of Blackbaud Internet Solutions, we have upgraded the jQuery version from 1.12.3 to
3.3.1. If you use custom JavaScript on your Blackbaud Internet Solutionspages, we recommend
additional testing to ensure this has not affected your user experience.
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Service Pack 19

Blackbaud Checkout Enhancements
To enable organizations to customize the theme on the Blackbaud Checkout page, we've implemented
a new option in Sites & settings. Because some organizations have branding guidelines that must be
followed, this enhancement allows administrators to change the font and colors on the Blackbaud
Checkout page to match your organization's brand. You can specify a theme to use site-wide and you
can also override the site-wide theme on individual forms.
Under Administration, Sites & settings, you can select the site you want to customize the Checkout
page for, then select the Settings tab.
In Blackbaud Checkout Theme Options, you can specify the default colors to use as the Primary
color and Secondary color for the Checkout page used on your site. You'll need to enter the 6-digit
hexidecimal value — such as #FF0000 — for the desired color. In Font, you can change the default font
(Roboto) for text displayed on the Checkout page by selecting from the list of available fonts.

On the Checkout page:
l Primary color is used on form buttons, the footer, and field highlights
l Secondary color is used for the background of validation errors
l Font is used for the header text, footer text, and all content

When the administrator has configured the Blackbaud Checkout theme, all checkout overlays displayed
from anywhere on the site will display the font, primary color, and secondary color that were specified,
unless you've overridden the site-wide defaults on an individual part.

Enhancements to the Donation Form - Mini Part
In this release, we've made several enhancements to the Donation Form - Mini part.

Support Apple Pay
Apple Pay is now available to donors as a secure checkout option.
Previously, this was only available for organizations in the Apple Pay Early Adopter Program (EAP); now
it is Generally Available.
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Removed "Beta" Designation from Part Name
The Donation Form - Mini part is no longer in beta status. We've removed "Beta" from the part name
to reflect this.

Donation Form - Mini is now AA Compliant
In our ongoing effort to ensure Blackbaud Internet Solutions commonly-used parts meet accessibility
standards, we're pleased to announce that the Donation Form - Mini part now meets the Web Content
Accessibility Guidelines (WCAG) 2.0 level AA compliance guidelines.

Checkout Page — Separate First Name and Last Name Fields
Constituent records in Blackbaud CRM use separate First Name and Last Name fields. Previously,
Blackbaud Internet Solutions used a single Cardholder Name field for Blackbaud Checkout, which
resulted in matching issues in Blackbaud CRM, since Blackbaud Checkout allows the Cardholder Name
to be collected as a separate first name and last name, Blackbaud Internet Solutions will now always
use these separate fields for data accuracy.

Checkout Page — Customize Page Theme and Digital Wallets
On the Design tab, when you select a merchant account under Payment setup that supports Blackbaud
Checkout, you'll see the Use site defaults for Blackbaud Checkout Theme option. This setting is
selected by default, and refers to the Blackbaud Checkout Theme Options specified in Administrator
> Sites & settings.
To override the site-wide default checkout theme, clear the Use site defaults for Blackbaud
Checkout theme option to enable the fields where you can enter values for the Primary color and
Secondary color, and select a different font.
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In addition, under Digital Wallets, you can choose which forms of payment — Visa Checkout or
MasterPass — are accepted during checkout. By default, all payment methods are selected.

Note: Digital wallets are only available for BBMS customers.

Event Registration Form Enhancements
We've made the following enhancements to the Event Registration Form 2.0.

Blackbaud Checkout
Previously, the Blackbaud Secure Payment page was used to take payments through the Event
Registration Form 2.0. Now, the form uses PCI-compliant Blackbaud Checkout for BBMS customers, so
credit card and merchant account information is processed and stored on a Blackbaud-hosted secure
server.
On the Design tab, when you select a merchant account under Payment options that supports
Blackbaud Checkout, you'll have the option to specify the checkout theme. You can use the default
option — Use site defaults for Blackbaud Checkout Theme — which uses the settings specified in
the Blackbaud Checkout Theme Options specified in Administrator > Sites & settings.
To override the site-wide default and customize the checkout theme, clear the Use site defaults for
Blackbaud Checkout theme option to enable the fields where you can enter values for the Primary
color and Secondary color, and select a different font.

In addition, under Digital Wallets, you can choose which forms of payment — Visa Checkout or
MasterPass — are accepted during checkout. By default, all payment methods are selected.

Note: Digital wallets are only available for BBMS customers.
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Per Pricing Option Limits
To enable administrators to limit the number of registrations per ticket option for an event, you can
now configure per pricing option limits.
When you edit an event, under Event price options, there's a new Max units setting. Use this setting
to select the maximum number of tickets for the event option.

For example, if you set the Max units to 4, registrants cannot register more than four people for that
event option. A message displays if there is a maximum ticket limit when registrants add attendees for
an event.
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You can use the Language tab to customize text that displays on the form. For example, you can
modify the text for the Maximum registrants per pricing option item to customize the message
displayed for the per pricing option limit for a ticket type.

Remove Unengaged Users When Sending
Emails
To enable you to remove unengaged users — those who haven't interacted with an email via an open
or a click in a specified period of time — from emails sent through Blackbaud Internet Solutions, we've
made an enhancement to the email settings.
On the Schedules tab in Administration > Sites & settings, we've added Inactive email recipient list
refresh settings that enable administrators to set the frequency that the business process will run to
remove email addresses that have been inactive for the specified number of months.

In Email > Inactive recipients, you can see a list of email addresses for inactive recipients, based on the
criteria specified in the Inactive email recipient list refresh settings in Administration > Sites &
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settings. The value displayed in Inactive from month(s) defaults to the value specified in
Administration > Sites & settings, but you can modify it to change the filter criteria. The Date of last
open and Date of last click for each email address is also displayed.

When you create a new message in Email > Messages, you can select the Exclude inactive recipients
option and specify the number of months (Inactive from month(s)) that recipients have been inactive.
The value displayed in Inactive from month(s) defaults to the value specified in Administration > Sites
& settings, but you can modify it. When you select Send Final, the email will not be sent to the inactive
recipients that meet the specified criteria.
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You can also select the Exclude inactive recipients and Inactive from month(s) options on email
templates. This enables you to configure these settings on a template, and then any email messages
created from the template will default with the values from the template.

Tip: For more information about unengaged/inactive users, see the Engagement and Email
Deliverability Resources blog post.

Event Batch Control Report Updates
To enable the Blackbaud Internet Solutions Event Batch Control report to provide applicable
information for finance reconciliation and other processes, we've updated the report to include more
details.
Previously, when you created the Blackbaud Internet Solutions Event Batch Control report after
committing an event registration transaction batch, the only information displayed in Blackbaud CRM
was the registrant name. Now, the report includes the batch summary details, and records containing
information about registrants and registered events is displayed such as:

l Registrant name
l Registration option
l Registration amount
l Number of registrants

WCAG 2.0 AA Compliant Forms
In our ongoing effort to ensure Blackbaud Internet Solutions commonly-used parts meet accessibility
standards, we're pleased to announce that Donation and Membership forms using the Payment 2.0
part, as well as the Mini Donation Form, now meet the Web Content Accessibility Guidelines (WCAG)
2.0 level AA compliance guidelines.
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Service Pack 20

Email Reports about Unengaged Users
New email reports will now show data about unengaged recipients. This enables you to better
understand unengaged users — those who haven't interacted with an email via an open or a click in a
specified period of time.
Previously, these were also known as "inactive" recipients. Therefore, we've updated the terminology
throughout the user interface to now use the term "unenaged" instead of "inactive."
However, email reports which existed prior to this release remain unchanged and will not show this
new data.

Tip: For more information about unengaged/inactive users, see the Engagement and Email
Deliverability Resources blog post. A previous update enabled you to choose to exclude unengaged
users from emails. For information about the previous update, see Remove Unengaged Users When
Sending Emails.

Additional Bounce Statuses
This release includes additional bounce statuses. These provide users with more information about
email addresses which were blacklisted due to spam complaints and emails previously marked as hard
bounces.
When you review unenaged recipients (who have inactive addresses), these additional bounce statuses
now appear in the list of emails that were not sent. You can filter the list based on these new statuses.
New bounce statuses also appear with the inactive email address on a recipient’s contact record and in
the Blacklisted Email Addresses tab in Blackbaud CRM.
For information about bounced emails and best practices for emails, refer to Blackbaud's Email
Resource Center.

Constituents to Review Spam Complaints
You can add a new element to the Communication Preference Form to enable online constituents
whose email address is associated with a spam complaint to review their email address and learn how
to remove their email address from the blacklist.
When you include the Spam Compliance element on the Communication Preference Form, the form
will show an icon and a customizable message to inform the individual that their email address
previously reported spam and thus emails can't be sent to that address for compliance reasons. The
element also includes a customizable message and URL to a Blackbaud KnowledgeBase article which
provides instructions which the user can follow to remove the user's email address from the email
suppression list.
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Additionally, this release helps organizations respect a recipient's right to unsubscribe. When a 
recipient opens an email in a supported email browser, an unsubscribe link can appear near the top of 
the email. The recipient can select the link to indicate the individual wants to globally unsubscribe 
from all emails sent by your organization. Recipients who unsubscribe are marked as not wanting emails 
and are handled as though the recipient had unsubscribed (globally) from the Blackbaud Internet 
Solutions communication preference form.

Unsent Email for a Constituent
In Blackbaud CRM, the Communications tab of a constituent record will now indicate that an email 
your organization intended for the constituent was not sent.
Previously, all emails which included the constituent's email address as an intended recipient were 
shown without distinctions. With this release, an alert icon appears next to any email that couldn't be 
sent due to a spam complaint, a hard bounce, a previous hard bounce, or a soft bounce. This enables 
you to review which messages did not reach the intended recipient and the reason for the delivery 
error.
The alert appears for email errors regardless of whether the email was generated from Blackbaud 
Internet Solutions or Blackbaud CRM.
For information about bounced emails and best practices for emails, refer to Blackbaud's Email 
Resource Center.

Apple Pay for Blackbaud Checkout
Apple Pay is now available to donors as a secure checkout option for Blackbaud Merchant Services 
(BBMS) customers in the United States and Canada.
Previously, this method of payment was only available for organizations in the Apple Pay Early Adopter 
Program (EAP); now it is Generally Available.
With the Donation Form - Mini part, you can now accept payments through Apple Pay when you use 
Blackbaud Merchant Services (BBMS to process one-time credit card donations. This new payment 
option enables your constituents on Apple devices to make donations without having to enter as much 
information on the donation form, because data such as their credit card number and billing address 
are already stored in their Apple Pay wallet.

Note: Refer to Apple's Terms and Conditions in the Blackbaud Checkout FAQs.

Additional Blackbaud Checkout Enhancements
This release expands enhancements that were introduced in service pack 19.

Customize Page Theme
Previously, we announced that organizations can customize the theme on the Blackbaud Checkout
page. This benefits administrators of organizations with branding guidelines who want to change the
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font and colors on the Blackbaud Checkout page to match your organization's brand. You can also
specify a theme to use site-wide and override the site-wide theme on individual forms. For more
information refer to Blackbaud Checkout Enhancements.
With this release, the Use site defaults for Blackbaud Checkout Theme option now appears
whenever you edit

l an Event Registration part
l Mini Donation Form (see Enhancements to the Donation Form - Mini Part on page 129 )
l an Advanced Donation Form
l a Payment 2.0 part

and select a merchant account that supports Blackbaud Checkout. The option is selected by default, 
but you can override it.
If you don't want to use the default theme, clear the Use site defaults for Blackbaud Checkout theme 
option. Then enter values for the Primary color and Secondary color and select a different font.

Checkout Page — Separate First Name and Last Name Fields
Likewise, when you edit event registration forms, advanced donation forms, or any Blackbaud Internet 
Solutions page using Payment 2.0, Blackbaud Internet Solutions now uses separate First Name and 
Last Name fields. Previously, these forms used a single Cardholder Name field for Blackbaud 
Checkout.

Checkout Page — Customize Page Theme and Digital Wallets
Additionally, under Digital Wallets, you can choose which forms of payment — Visa Checkout, 
MasterPass, or Apple Pay— are accepted during checkout for event registration forms, advanced 
donation forms, or any Blackbaud Internet Solutions page using Payment 2.0. By default, all payment 
methods are selected.

Note: Digital wallets are only available for Blackbaud Merchant Services customers.
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